flexAnalysis 3.4
User Manual
Legal and Regulatory Notices

Copyright © 2011

Bruker Daltonik GmbH

All other trademarks are the sole property of their respective owners.

All Rights Reserved

Reproduction, adaptation, or translation without prior written permission is prohibited, except as allowed under the copyright laws.

Document History

flexAnalysis 3.4 User Manual Revision 1 (November 2011)

Part number: # 282592

First edition: November 2011

Warranty

The information contained in this document is subject to change without notice.

Bruker Daltonik GmbH makes no warranty of any kind with regard to this material, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose.

Bruker Daltonik GmbH is not liable for errors contained herein or for incidental or consequential damages in connection with the furnishing, performance or use of this material.

Bruker Daltonik GmbH assumes no responsibility for the use or reliability of its software on equipment that is not furnished by Bruker Daltonik GmbH.

Use of Trademarks

The names of actual companies and products mentioned herein may be the trademarks of their respective owners.
Limitations on Use

For Research Use Only (RUO). Not for use in diagnostic procedures.

Hyperlink Disclaimer

Bruker Daltonik GmbH makes no express warranty, neither written nor oral, and is neither responsible nor liable for data or content from the linked Internet resources presented in this document.

Contact

Contact your local Bruker Daltonics representative for service and further information.

<table>
<thead>
<tr>
<th>USA</th>
<th>Germany</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bruker Daltonics Inc</td>
<td>Bruker Daltonik GmbH</td>
</tr>
<tr>
<td>40 Manning Road</td>
<td>Fahrenheitstraße 4</td>
</tr>
<tr>
<td>Billerica, MA 01821</td>
<td>28359 Bremen</td>
</tr>
<tr>
<td>USA</td>
<td>Germany</td>
</tr>
<tr>
<td>Phone: +1 978 6633660</td>
<td>Phone: +49 421 2205-345</td>
</tr>
<tr>
<td>Fax: +1 978 6675993</td>
<td>Fax: +49 421 2205-390</td>
</tr>
<tr>
<td>Internet: <a href="http://www.bdal.com">www.bdal.com</a></td>
<td>Internet: <a href="http://www.bdal.de">www.bdal.de</a></td>
</tr>
</tbody>
</table>

**Service Support**

<table>
<thead>
<tr>
<th>USA</th>
<th>Germany</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone: +1 978 6633660-1445</td>
<td>Phone: +49 421 2205-350</td>
</tr>
<tr>
<td>E-mail: <a href="mailto:service-support@bdal.com">service-support@bdal.com</a></td>
<td>E-mail: <a href="mailto:maldi.sw.support@bdal.de">maldi.sw.support@bdal.de</a></td>
</tr>
</tbody>
</table>
Typographic and Application Conventions

These conventions list the font styles used for indicating specific graphical user interface (GUI) elements (e.g. menu Items).

They also list the meanings of terms used to describe user interactions with the graphical user interface of software (e.g. right-click).

Typographic Conventions

File and Directory Names and Paths

File and directory names and paths are written in regular type.

Example: "Go to the C:\Bruker\solariXcontrol\test directory and open the file test_1.txt."

GUI elements

GUI (graphic user interface) elements are options that are available in software that enable a user to interact with the software without using the keyboard.

Typical GUI elements include windows, menus, menu options, drop-down lists, and buttons.

- Names of windows are written in regular, capitalized type.
- Names of text entry fields and buttons are written in **bold** type.

  Example: "In the New Digest window, type a **Name** (obligatory) and **Note** (optional) and click **Next**."

- GUI menus and command names are written in **bold** type.

  Example: "Select **Window > Show View > LC-MS Survey**."

Keyboard

References to keys on the keyboard are written in **UPPER CASE**.

Example: "Press ALT+F4."

Publications

References to electronic and printed documents are written in *italic type*.

Example: "See the *ProteinScape Administrator Manual* for more details."
URLs

Uniform Resource Locators (URLs) are written in italic type. The protocol name (for example, http://) is usually omitted.
Example: "Visit www.bdal.com for more details."

Keyboard Conventions

Press

Use the indicated key(s) on the keyboard. When modifier keys (e.g. SHIFT, ALT, CTRL) are indicated, keep them pressed while pressing the other key.
Example: "To toggle between Table and Spectrum view press CTRL+F3."

GUI User Interactions

Clear

Deactivate a software feature by positioning the mouse cursor over a selected check box and pressing the left mouse button.
Example: "Clear the Curve Smoothing option."

Click

Position the mouse cursor over a GUI element and press the left mouse button to start an action in the software.
Example: "Click OK."

Click and drag

Position the mouse cursor in a window and press the left mouse button. Hold the left mouse button down and move the cursor to select a (usually rectangular) area.
Example: "Zoom in on peaks of interest by clicking and dragging in the Spectrum window."

Double-click

Position the mouse cursor over a GUI element and press the left mouse button twice in quick succession to start an action in the software.
Example: "Double-click the Sample icon."
Drag and drop

Position the mouse cursor over a GUI element and press the left mouse button.
Hold the left mouse button down and move the selected element to a new location.
Example: "Drag and drop the tab into the desired tab group."

Select

Navigate to a desired menu command.
Example: "Select File > Zip > Zip Project..."
Position the mouse cursor over a GUI element (e.g. a table entry) and press the left mouse button to highlight it.
Example: "Select the desired file in the list and click Export."
Activate a software feature by positioning the mouse cursor over an empty check box and pressing the left mouse button.
Example: "Select the Curve Smoothing option."

Right-click

Position the mouse cursor over a GUI element and press the right mouse button to open a menu for the selected element.
Example: "Right-click in the Spectrum View window".
# Table of Contents

Legal and Regulatory Notices ............................................................................................................ 2  
Contact ................................................................................................................................................. 3  
Typographic and Application Conventions .......................................................................................... 4  
Table of Contents .................................................................................................................................. 7  

## 1 Introduction ........................................................................................................................................ 13  
   1.1 Getting Started ............................................................................................................................ 15  
   1.2 Installing flexAnalysis 3.4 .......................................................................................................... 15  
   1.3 Removing flexAnalysis 3.4 .......................................................................................................... 15  
   1.4 Licensing flexAnalysis 3.4 .......................................................................................................... 15  
   1.5 Starting and Closing flexAnalysis 3.4 ......................................................................................... 18  

## 2 Graphical User Interface (GUI) .................................................................................................... 19  
   2.1 Title Bar ....................................................................................................................................... 20  
   2.2 Toolbar ....................................................................................................................................... 20  
   2.3 Status Bar .................................................................................................................................... 20  
   2.4 Menu Bar .................................................................................................................................... 21  
      2.4.1 File Menu ............................................................................................................................... 22  
      2.4.1.1 Open .................................................................................................................................. 24  
      2.4.1.2 Open Single Analysis ........................................................................................................ 26  
      2.4.1.3 Close ................................................................................................................................. 27  
      2.4.1.4 Close All ............................................................................................................................ 27  
      2.4.1.5 Load and Unload ............................................................................................................... 27  
      2.4.1.6 Save ................................................................................................................................. 28  
      2.4.1.7 Save As .............................................................................................................................. 29  
      2.4.1.8 Save All ............................................................................................................................ 29  
      2.4.1.9 Sign Electronic Record ..................................................................................................... 29  
      2.4.1.10 Show Signatures ............................................................................................................. 29  
      2.4.1.11 Export ............................................................................................................................. 31  
      2.4.1.12 Properties ....................................................................................................................... 32  
      2.4.1.13 Exit ................................................................................................................................... 34  
   2.4.2 Edit Menu ................................................................................................................................... 35  
      2.4.2.1 Copy .................................................................................................................................. 37
| 2.4.2.2  | Paste ................................................................. | 37 |
| 2.4.2.3  | Paste Special ..................................................... | 37 |
| 2.4.2.4  | Delete ....................................................................... | 38 |
| 2.4.2.5  | Select All .................................................................. | 38 |
| 2.4.2.6  | Select None .................................................................. | 38 |
| 2.4.2.7  | View Analysis ................................................................ | 39 |
| 2.4.2.8  | View Spectrum ................................................................ | 39 |
| 2.4.2.9  | Set Color ..................................................................... | 39 |
| 2.4.2.10 | Default Color ................................................................ | 40 |
| 2.4.2.11 | Set Selection Range .................................................. | 40 |
| 2.4.2.12 | Clear Selection ................................................................ | 40 |
| 2.4.2.13 | Box Selection ................................................................ | 40 |
| 2.4.3   | Mass List Menu .......................................................... | 41 |
| 2.4.3.1 | Find ............................................................................. | 42 |
| 2.4.3.2 | Edit .............................................................................. | 43 |
| 2.4.3.3 | Edit Direct ..................................................................... | 43 |
| 2.4.3.4 | Clear ............................................................................ | 44 |
| 2.4.3.5 | MS/MS List ..................................................................... | 44 |
| 2.4.3.6 | Edit Mass Control List ............................................... | 46 |
| 2.4.3.7 | Identify Background Peaks ........................................ | 47 |
| 2.4.3.8 | Remove Background Peaks ............................................ | 49 |
| 2.4.3.9 | Distance in Mass List(s) ............................................... | 49 |
| 2.4.4   | Process Menu ................................................................... | 51 |
| 2.4.4.1 | Smooth Mass Spectrum .................................................. | 52 |
| 2.4.4.2 | Subtract Mass Spectrum Baseline ................................... | 52 |
| 2.4.4.3 | Undo All Processing .................................................... | 52 |
| 2.4.4.4 | Batch Process .................................................................. | 52 |
| 2.4.4.5 | Process Spectra ........................................................... | 58 |
| 2.4.5   | Calibrate Menu .............................................................. | 59 |
| 2.4.5.1 | Internal .......................................................................... | 60 |
| 2.4.5.2 | Copy Calibration .......................................................... | 71 |
| 2.4.5.3 | Replace Calibration ...................................................... | 71 |
| 2.4.5.4 | Apply Raw Calibration ................................................... | 72 |
2.4.6  Annotation Menu ................................................................. 72
  2.4.6.1  Annotate ................................................................. 73
  2.4.6.2  Clear ................................................................. 75
  2.4.6.3  Show Mass Difference .............................................. 75
  2.4.6.4  Preview Assignments ............................................... 76
  2.4.6.5  Edit Building Blocks .............................................. 77
2.4.7  Method Menu ................................................................. 78
  2.4.7.1  Open ................................................................. 80
  2.4.7.2  Save ................................................................. 82
  2.4.7.3  Save As ............................................................. 82
  2.4.7.4  Run Script ........................................................... 83
  2.4.7.5  Edit Parameters .................................................... 83
  2.4.7.6  Edit Processing Parameters ..................................... 101
  2.4.7.7  Edit Script .......................................................... 102
  2.4.7.8  Select Default ..................................................... 103
2.4.8  FAST Menu ................................................................. 104
  2.4.8.1  Paste Segment Spectra ........................................... 104
  2.4.8.2  Change Parameters ................................................ 106
  2.4.8.3  Delete Segment Spectra .......................................... 107
2.4.9  View Menu ................................................................. 108
  2.4.9.1  Viewing Mass Spectra ............................................. 108
  2.4.9.2  Auto-Scaling ....................................................... 109
  2.4.9.3  Scale to Entire Spectrum ........................................ 110
  2.4.9.4  Horizontal and Vertical Auto Scaling ....................... 110
  2.4.9.5  Set Display Range ................................................ 110
  2.4.9.6  Zoom ............................................................... 111
  2.4.9.7  Zoom X ............................................................. 111
  2.4.9.8  Undo Zooming ..................................................... 111
  2.4.9.9  Redo Zooming ...................................................... 111
  2.4.9.10  Toolbars .......................................................... 112
  2.4.9.11  Status Bar ........................................................ 113
2.4.10 Report Menu .............................................................. 113
  2.4.10.1  Print Preview ..................................................... 113
# Table of Contents

2.4.10.2 Print ........................................................................................................ 115
2.4.10.3 Save As PDF .......................................................................................... 116
2.4.10.4 Save As HTML ........................................................................................ 117
2.4.10.5 Report Designer .................................................................................... 117

## 2.4.11 Tools Menu ............................................................................................ 119
  2.4.11.1 BioTools ................................................................................................. 120
  2.4.11.2 PolyTools ............................................................................................... 120
  2.4.11.3 ProteinScape ......................................................................................... 121
  2.4.11.4 SmartFormula Manually ...................................................................... 124
  2.4.11.5 Macro Editor .......................................................................................... 133
  2.4.11.6 Customize .............................................................................................. 134
  2.4.11.7 Options .................................................................................................. 136
  2.4.11.8 Colors ................................................................................................... 143
  2.4.11.9 Glycopeptides ....................................................................................... 144
  2.4.11.10 Send Spectra to ProteinScape .............................................................. 144

## 2.4.12 Window Menu .......................................................................................... 145
  2.4.12.1 Analysis List .......................................................................................... 145
  2.4.12.2 Mass Spectrum ...................................................................................... 145
  2.4.12.3 Mass List ................................................................................................ 146
  2.4.12.4 Sequence List ........................................................................................ 146
  2.4.12.5 SmartFormula List ............................................................................... 146

## 2.4.13 Compass Menu ....................................................................................... 146
  2.4.13.1 License .................................................................................................. 147
  2.4.13.2 Operator ................................................................................................. 148
  2.4.13.3 Lock All Applications .......................................................................... 148
  2.4.13.4 Compass Desktop ................................................................................ 149
  2.4.13.5 flexControl ............................................................................................ 149
  2.4.13.6 BioTools ................................................................................................ 149
  2.4.13.7 Audit Trail Viewer ............................................................................... 150

## 2.4.14 Help Menu ............................................................................................... 150
  2.4.14.1 Help Topics ............................................................................................ 151
  2.4.14.2 About Bruker Daltonics flexAnalysis .................................................. 151
# Table of Contents

2.5  Window Areas. ................................................................................................................. 152
2.5.1 Analysis List Window. ................................................................................................. 152
2.5.2 Mass Spectrum Window. .............................................................................................. 152
2.5.3 Mass List Window. ........................................................................................................ 153
2.5.4 Sequence List Window. .................................................................................................. 153
2.5.5 SmartFormula List Window. .......................................................................................... 153
2.6  flexAnalysis Window Shortcut Menus. ............................................................................... 153
2.6.1 Analysis List Window (Tree View) Shortcut Menu. .......................................................... 153
2.6.2 Mass Spectrum Window (Display View) Shortcut Menu. ............................................... 154
2.6.3 Mass List (Peak List) View Shortcut Menu. .................................................................... 156
2.7  Pointers and Interactive Modes. ......................................................................................... 158
2.8  flex Data Converter. .......................................................................................................... 160

Appendix A — Calibration ....................................................................................................... 169
A.1  Calibration Procedures. ...................................................................................................... 169
  A.1.1 Performing an Internal Calibration Using the Statistical Peptide Calibration Feature. ........................................................................................................... 169
  A.1.2 Performing an Internal Calibration Using the Automatic Assignment Feature. ........................................................................................................... 169
A.2  High-Precision Polynomial Calibration (HPC). ................................................................. 170
  A.2.1 What is HPC? .............................................................................................................. 170
  A.2.2 Using HPC .................................................................................................................. 170
  A.2.1 Checking HPC Performance ........................................................................................ 171
A.3  Table of Valences .............................................................................................................. 171

Index ....................................................................................................................................... 173
1 Introduction

flexAnalysis 3.4 is the post processing software for spectra acquired with the Bruker time-of-flight mass spectrometers of the flex series. The program runs under XP (SP3), 32 bit, and Windows 7 (64 bit) operating systems. Windows NT, Windows 2000, and Windows Vista are not supported.

Before installing flexAnalysis 3.4 for the first time, the program Microsoft .NET Framework -3.5 must be installed, because flexAnalysis is based on features, which Microsoft .NET Framework 3.5 provides. This program is also part of the Compass installation DVD (see Figure 1-1).

Figure 1-1  Compass DVD

flexAnalysis uses standard Microsoft Windows conventions to operate with windows, menus, dialog boxes, and the mouse. The operator is supposed to be familiar with the basic operation of the computer and with Microsoft Windows software. Some general instructions are given here, but if additional support is necessary regarding the basic use of a computer, please review its accompanying documentation.

flexAnalysis 3.4 is able to operate in combination with the Bruker Compass Security Pack 2.0. This program can be installed prior to flexAnalysis or after it.

Main features of the Bruker Compass Security Pack are a user management, electronic signatures and audit trailing. This is different to the user management of the operating
system! The Bruker User Management is a tool that allows you to manage the access to Bruker applications and assign individual rights to users. Depending on these rights the access of a user to features of Bruker applications is more or less restricted.

On saving data files, the operator can electronically sign them, if he has got this specific right. Electronic signatures consist of the operator ID and his password (see Figure 2-10).

Audit trails are useful to trace back the operations of a user he made in a specific moment.

The Bruker Compass Security Pack and user management are described in a separate manual.

flexAnalysis 3.4 provides the following key features:

- Multiple spectrum display for convenient spectra comparison and analysis.
- Highly sophisticated algorithms for authentic automated and interactive peak detection (SNAP, Centroid, and Sum peak finder).
- Highly sophisticated algorithms for spectrum processing (smoothing, baseline subtraction).
- Highly sophisticated algorithms for automated and interactive recalibration of spectra (linear, quadratic, cubic enhanced, statistical and iCal support).
- MS/MS support: Presentation and processing of LIFT spectra as well as generation of FAST spectra.
- Annotation
- Spectrum and graphic export.
- Report designer for creating user defined analysis reports and specific report layouts.
- Integrated Sax Basic Development Environment for the design of flexAnalysis methods and scripts. Sax Basic is Visual Basic for applications™ compatible.
- Proteineer Support: Integrated data exchange with BioTools and ProteinScape program packages.
- Data processed in flexAnalysis 3.4 can be delivered in form of spectra and peak lists to further interactive data processing software packages such as GenoTools (SNP
[Single Nucleotide Polymorphisms], genotyping analysis) or Polytools (monomer
determination, average molecular weight).

1.1 Getting Started

In case of installing flexAnalysis 3.4 as a standalone version, it can be installed from the
Compass 1.4 installation DVD (see Figure 1-1).

1.2 Installing flexAnalysis 3.4

Please refer to the separate installation instructions on the Compass installation DVD, or
contact Bruker via e-mail (see "Contact" on page 3).

1.3 Removing flexAnalysis 3.4

1. Start your Windows application.
2. Select Start > Settings > Control Panel.
3. Double-click Add/Remove Programs.
4. From the applications list, select Bruker Daltonics flexAnalysis 3.4.
5. Click Add/Remove.
6. Follow the Install Shield Wizard instructions to remove flexAnalysis 3.4 from your
   system.

1.4 Licensing flexAnalysis 3.4

A 60-day-license is installed together with the first installation of flexAnalysis 3.4. After it
has expired a dialog appears (see Figure 1-2).
Figure 1-2  FA is not yet licensed

After applying the **OK** button the Bruker Daltonics LicenseManager (see Figure 1-3) opens. The Compass license key comes in a separate envelope with the software.

![Bruker Daltonics LicenseManager](image)

Figure 1-3  The Bruker Daltonics LicenseManager.

Click **Edit** and, if necessary, confirm some dialogs or enter the requested administrator password. Afterwards enter the key in the edit field **New License Key** and press the **Add** button.
Figure 1-4   Typing a new license key into the Bruker Daltonics LicenseManager

If the Bruker Compass Security Pack is installed licenses can only be added or removed by users who have the corresponding right. In this case a dialog appears where users can enter the password (see Figure 1-5).

Figure 1-5   Enter the password to add or delete a license key

A license key can be removed with the Delete button. Before deletion, a warning appears (see Figure 1-6).
Figure 1-6 \quad \textbf{Warning before deleting a license}

The \texttt{Bruker Daltonics LicenseManager} dialog box can also be launched from the Compass menu with the \texttt{License} command (see section 2.4.13.1).

\section*{1.5 Starting and Closing \texttt{flexAnalysis 3.4}}

\textbf{Starting \texttt{flexAnalysis 3.4}}

\texttt{flexAnalysis 3.4} can be started via the Windows \texttt{Start} menu. During installation of the Bruker Daltonics Applications package, a Bruker Daltonics folder was automatically created in the \texttt{Start menu's Programs} folder, which contains the applications delivered by Bruker Daltonik. Select the \texttt{flexAnalysis} entry from this folder in order to start \texttt{flexAnalysis 3.4}. A second way to launch \texttt{flexAnalysis 3.4} is double clicking the corresponding icon on the Windows desktop.

\textbf{Closing \texttt{flexAnalysis 3.4}}

This procedure closes \texttt{flexAnalysis 3.4}. On closing, the current user interface settings are automatically stored.

In order to exit \texttt{flexAnalysis 3.4} click the application's Close button or from the \texttt{File} menu select \texttt{Exit}, or press ALT+F4.

If required, answer the appearing confirmation request to save the current processing state of a modified analysis.
2 Graphical User Interface (GUI)

The GUI is composed of the following items:

- Title bar (see section 2.1)
- Menu bar (see section 2.4)
- Toolbar (see section 2.2)
- Analysis List window (see section 2.5.1)
- Mass Spectrum window (see section 2.5.2)
- Mass List window (see section 2.5.3)
- Sequence List window (see section 2.5.4)
2.1 Title Bar

The title bar (see Figure 2-2) contains the name of the application, and, if one analysis is selected, the title of the analysis file. If a title is not set in the flexAnalysis **Properties** dialog, the first two comments, (see Figure 2-14) are displayed in the title bar. The left end of the title bar contains the application’s **Control menu** button. The right end contains the familiar Windows **Minimize**, **Maximize**, and **Close** buttons.

Figure 2-2 Title bar of flexAnalysis 3.4

2.2 Toolbar

Feature buttons have been given for commands that are regularly used. These buttons are organized into several groups and can be found also in the menus.

Figure 2-3 flexAnalysis toolbar

2.3 Status Bar

The status bar (see Figure 2-4) is located at the bottom of the GUI. In the middle it contains the sample name of the currently active spectrum for a saved spectrum (automsms\0_{I14}) or the name of the loaded processing method (PMF [read-only]) as long as the spectrum is not saved.

Figure 2-4 Examples of a Status Bar for a saved and un-saved spectrum
The second field displays the parent mass in case of fragment spectra (not shown here).

The third field shows the selection mode (Annotate), which is currently active. The next field shows the name of the current user followed by two fields that show the current mouse pointer position in the Mass Spectrum window.

### 2.4 Menu Bar

The menu bar (see Figure 2-5) consists of 13 drop-down menus. These menus contain all the features to operate flexAnalysis. Open a menu with the left mouse button, for example the File menu as shown in the following section.

Most of the features that are available in these menus can be found also as buttons in the button bar, or as entries in the shortcut menus of the three main flexAnalysis windows.

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>Mass List</th>
<th>Process</th>
<th>Calibrate</th>
<th>Annotation</th>
<th>Method</th>
<th>FAST</th>
<th>View</th>
<th>Report</th>
<th>Tools</th>
<th>Window</th>
<th>Compass</th>
<th>Help</th>
</tr>
</thead>
</table>

**Figure 2-5** Content of the flexAnalysis menu bar
2.4.1 File Menu

Figure 2-6 Contents of the File menu

The File menu is composed of commands to open, close and save data, handle the user management.
Table 2-1  Features of the File menu

<table>
<thead>
<tr>
<th>Feature button</th>
<th>File menu commands</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Open icon]</td>
<td>Open</td>
<td>CTRL+O</td>
<td>Opens the <strong>Open multiple spectra</strong> dialog.</td>
</tr>
<tr>
<td>![Open single Analysis icon]</td>
<td>Open single Analysis</td>
<td>CTRL+SHIFT+O</td>
<td>Opens one selected analysis.</td>
</tr>
<tr>
<td>![Close icon]</td>
<td>Close</td>
<td>CTRL+F4</td>
<td>Closes the selected analysis or analyses.</td>
</tr>
<tr>
<td>![Close All icon]</td>
<td>Close All</td>
<td></td>
<td>Closes all analyses.</td>
</tr>
<tr>
<td>![Load icon]</td>
<td>Load</td>
<td></td>
<td>Loads an analysis in the tree view.</td>
</tr>
<tr>
<td>![Unload icon]</td>
<td>Unload</td>
<td></td>
<td>Unloads an analysis from the tree view.</td>
</tr>
<tr>
<td>![Save icon]</td>
<td>Save</td>
<td>CTRL+S</td>
<td>Saves results of the selected analyses including the method.</td>
</tr>
<tr>
<td>![Save As icon]</td>
<td>Save As</td>
<td></td>
<td>Saves results of the selected analyses including the method to a user specific location.</td>
</tr>
<tr>
<td>![Save All icon]</td>
<td>Save All</td>
<td>SHIFT+CTRL+S</td>
<td>Saves results and method of all open analyses.</td>
</tr>
<tr>
<td>![Sign Electronic Record icon]</td>
<td>Sign Electronic Record</td>
<td></td>
<td>Signs an electronic record.</td>
</tr>
<tr>
<td>![Show Signatures icon]</td>
<td>Show Signatures</td>
<td></td>
<td>Shows the signature of a signed file.</td>
</tr>
<tr>
<td>![Export icon]</td>
<td>Export</td>
<td></td>
<td>Offers various possibilities to export data.</td>
</tr>
<tr>
<td>![Properties icon]</td>
<td>Properties</td>
<td>ALT+ENTER</td>
<td>Displays analysis and mass spectrum properties (variable table).</td>
</tr>
<tr>
<td>![Exit icon]</td>
<td>Exit</td>
<td>ALT+F4</td>
<td>Closes flexAnalysis.</td>
</tr>
</tbody>
</table>
2.4.1.1 Open

The **Open** command opens the **Spectrum Browser** dialog that allows selecting and loading spectra depending on several filter criteria (it is not necessary to select the `fid` file to load a spectrum).

flexAnalysis reads two kinds of spectra formats:

1. The Xmass file format. In this file format raw data are stored in a file called `fid`. Data already processed from flexAnalysis are stored in a file called `lr`. If the analysis was not processed before, the raw data file `fid` is loaded, otherwise the result spectrum of the process (`lr`). All this happens automatically, the user can only select the `fid`.

2. The Container file format. This file format is written only during AutoXecute runs that are started from WARP-LC or from flexImaging. In the container data format, all data from an AutoXecute run with the same sample name are saved in a single directory with a `.d` extension that contains only a few files. Bruker software never prompts for files within the directory, it only requests the `.d` directory.

When spectra are loaded and processed in flexAnalysis no difference is seen between XMass and Container spectra.
**Figure 2-7  Spectrum Browser**

- **Browse**: Select the folder from the hard drive with the data of interest.

- **Root**: Shows the selected path and folder.

- **Filter Spectra**: Select checkboxes to filter the data type you want to open. If the data structures correspond to the flexControl saving convention, a tree structure is displayed on the left side of the dialog (see Figure 2-7). If the saving convention is not applied select the checkbox **Unknown** to let the data appear.

- **From – To**: Time filter to search for spectra.

- **Spectrum Properties**: Shows the properties of a selected spectrum.
- **Spectra selected**: Displays the number of selected spectra. Applying the button **Clear Selection** sets it to 0.

- **Spectra**: Shows the number of selected spectra in comparison to the total number of spectra found in the chosen root directory.

- **Open**: Loads all selected spectra in flexAnalysis and closes the **Spectrum Browser**.

- **Cancel**: Closes the Spectrum Browser without loading a file.

- **Select All**: Selects all folders and subfolders of the chosen root directory.

- **Clear Selection**: Undoes the **Select All** function.

- **Load all selected spectra**: Loads and opens the spectra in flexAnalysis.

- ****: Updates the **Selected spectra** view

### 2.4.1.2 Open Single Analysis

In contrast to the **Open** command where one or more spectra can be opened at the same time the **Open Single Analysis** command opens only one spectrum. Here it is necessary to browse to the fid file (in the spectrum tree) and select it.

Additionally to the spectrum a method is loaded automatically. A flexAnalysis method determines how to process an analysis. The method that is loaded together with the analysis is either specified by the analysis itself (due to method assignment during the save process in flexControl) or, if no specification has been done in flexControl or AutoXecute, by the Default Method selection (see section 2.4.7.8).

If a spectrum has never been saved with flexAnalysis before, the method script (part of the method) is executed.

The drag and drop mechanism to open spectra works as follows:

1. Start flexAnalysis.

2. Start the Windows Explorer.

3. Navigate for the folder that contains the spectrum/spectra you want to open.

4. Drag and drop the selected folder on the display windows of flexAnalysis.
In case of loading FAST spectra that have been acquired with flexControl 1.x, and therefore have no valid calibration, a dialog appears to load the matching calibration file (*.psd) (see Figure 2-8).

![Warning dialog](image)

**Figure 2-8** Searching for FAST calibration files

### 2.4.1.3 Close

Spectra are closed with the Close command, the corresponding icon of the toolbar, or the short cut (CTRL+F4).

The feature closes only those analyses that are marked in the Analysis List Window. In case the analyses are currently not saved a confirmation dialog appears and asks for saving before closing.

### 2.4.1.4 Close All

The Close All command closes all open analyses. In case any spectrum is currently not saved a confirmation dialog appears and asks for saving before closing.

### 2.4.1.5 Load and Unload

The Load command loads the data of an analysis that is open but not yet loaded (see Figure 2-9) in the flexAnalysis tree view from the hard drive in the memory. The Unload command unloads them again.

Alternatively you can click with the mouse in the corresponding checkboxes in the Analysis List Window to load the analysis.
Loaded and unloaded spectra in the tree view

If you want to open a large number of spectra in the flexAnalysis tree view without loading them all at once, you may open them with the Spectrum Browser Open command, (see Figure 2-7). In this dialog you will find the checkbox Load all selected spectra at the bottom. For loading a lot of spectra the checkbox should not be activated. Otherwise, if you only want to load few spectra at once, activate this box.

If you want to change the order of the loaded (and unloaded) spectra in the tree view, just move one spectrum with pressed left mouse key to the desired place.

2.4.1.6 Save

The Save command, the corresponding icon of the toolbar, and the short cut (CTRL+S) store the current processing state of the selected analysis including the processing method.

The Save command can be applied to several selected analyses at a time after these have been marked in the tree view with the <Shift> or <Ctrl> - keys of the keyboard thus following Windows conventions.
2.4.1.7  Save As

The **Save As** command is used to save the selected analyses including the method with a new name and to a new location.

2.4.1.8  Save All

The **Save All** command or the short cut (Shift + CTRL+S) stores the result spectra of all opened analyses at once, including the processing methods.

2.4.1.9  Sign Electronic Record

The **Sign Electronic Record** command is used to sign spectra electronically when they have been processed. It is only available if additionally the Bruker Compass Security Pack is installed. After a spectrum is signed it is write-protected.

To sign a spectrum it is necessary that the user who wants to sign has the UserManagement given right to sign. This is checked during the sign process when the user fills in his Operator name and password (see Figure 2-10). The field Meaning may be used for comments.

![Sign Electronic Record dialog](image)

**Figure 2-10  Sign Electronic Record dialog**

2.4.1.10  Show Signatures

The **Show Signatures** command is also only available if additionally the Bruker UserManagement is installed and becomes active if a signed file is marked in the tree
view. It opens the **View Signatures** dialog.

![View Signatures dialog](image)

**Figure 2-11** View Signatures dialog

- **Date**: This column shows the date and your local time. The value most right in this example +1:00 corresponds to GMT +/- your time zone.

- **Signed by**: This column contains the name of the user, who has signed the spectrum.

- **Meaning**: This column contains the comment that has been entered during signing.

- **Valid**: This column contains remarks about the current validity status of data. In this example the validity is not yet checked. To do so apply the “Check Validity” button. The attribute unknown will change to valid.

A double click on a signature in the list opens a dialog that shows if the state of all checked files is ok.

![List of files](image)

**Figure 2-12** List of files, three file are mismatched
2.4.1.11 Export

The Export command is used to export spectra and graphics into other applications, or a peak list to Excel. To retain versatility spectra are exported in the common ASCII-file format, whereas graphics are exported in the common emf format (Windows Enhanced Metafile).

On selecting the Export\Mass Spectrum command the Export Mass Spectrum dialog appears to save a 2-column tabular with pairs of data points ($m/z$ / intensity). Type a file name into the field File name and press the Save button. flexAnalysis creates the corresponding file. With this macro only one mass spectrum can be exported. With the batch processing macro and a suitable flexAnalysis method more than one mass spectrum can be exported at the same time. The method does not belong to the standard installation, please contact maldi.sw.support@bdal.de.

On selecting the Export\Graphic command the Export Graphic dialog appears to specify the file name and location to export a graphic.

The Export\Raw Spectrum as mzXML option offers the export of the unprocessed spectrum in the mzXML format. A dialog appears to specify the file name and location. If you want to export more than one spectrum at a time into the mzXML format, the Bruker program CompassXport will be a good choice. It is available for download from our homepage.

The Export\Mass List to Excel command exports the peak list to Excel (see Figure 2-13). This macro exports all available peak list parameter. If you want to export only some of them please contact maldi.sw.support@bdal.de.

![Microsoft Excel - Book2](image)

Figure 2-13 Mass list exported to Excel
2.4.1.12 Properties

The Properties dialog is opened by selecting File > Properties, clicking the corresponding icon of the toolbar or double-clicking the first line of an analysis in the tree view, or pressing ALT+ENTER.

The Properties dialog consists of the General page, the Mass Spectrum page, and the Calibration page. A fourth possibility to open the Properties dialog is from the shortcut menu of a spectrum in the tree view.

All three tabs are displayed, if the operator has previously selected only one spectrum in the Analysis List window. In case of multiple spectra selection only the General tab appears.

![Properties dialog](Image)

**Figure 2-14** Contents of the General tab.

The General tab (see Figure 2-14) is used to display general information regarding the selected analysis such as file name, sample, mass spectrometer, title, and comments specific to the current analysis. Changes of title and comments can be performed and accepted by pressing Apply.
Figure 2-15  Contents of the Mass Spectrum tab

The Mass Spectrum tab (see Figure 2-15) is not editable. It displays groups of acquisition and processing parameters of the current analysis. The group arrangement and the distribution of the parameters have been done according to flexControl. The flexAnalysis parameter groups for example have the same names as the tabs in flexControl where the acquisition parameter can be adjusted.
Figure 2-16  Contents of the Calibration tab

The Calibration tab (see Figure 2-16) can be used to verify the calibration. Additionally some general information about the calibration are shown: calibration mode, source spectrum in case of an external calibration, and so on).

flexControl and flexAnalysis 3.4 store the calibration state along with each spectrum. The calibration state not only denotes the time stamp of a calibration, but the complete calibration information including assigned peaks. This information is visualized in the flexAnalysis spectrum properties. The information is updated whenever a spectrum is (re)calibrated in flexAnalysis. This means that without a (re)calibration having been performed in flexAnalysis, the shown calibration date is the calibration date of the flexControl method. The calibration information shown in the dialog can be saved as text file with the button Save.

2.4.1.13  Exit

The Exit command and the short cut (ALT+F4) are used to close flexAnalysis. However before closing a dialog may open and ask you to save modified analyses.
2.4.2 Edit Menu

Figure 2-17 Contents of the Edit menu

The Edit menu contains commands to work with the appearance of spectra in the three main windows.
<table>
<thead>
<tr>
<th>Feature button</th>
<th>Edit menu commands</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Copy Icon]</td>
<td>Copy</td>
<td>CTRL+C</td>
<td>Copies the selection (context dependent) and puts it on the Clipboard.</td>
</tr>
<tr>
<td>![Paste Icon]</td>
<td>Paste</td>
<td>CTRL+V</td>
<td>Inserts the contents of the clipboard.</td>
</tr>
<tr>
<td>![Paste Special Icon]</td>
<td>Paste Special</td>
<td></td>
<td>Pastes methods, method parameters or method scripts.</td>
</tr>
<tr>
<td>![Delete Icon]</td>
<td>Delete</td>
<td>DELETE</td>
<td>Deletes the selected mass spectrum.</td>
</tr>
<tr>
<td>![Select All Icon]</td>
<td>Select All</td>
<td>CTRL+A</td>
<td>Selects all open analyses including all mass spectra.</td>
</tr>
<tr>
<td>![Select None Icon]</td>
<td>Select None</td>
<td>CTRL+D</td>
<td>Deselects all currently selected analyses, and/or mass spectra.</td>
</tr>
<tr>
<td>![View Analysis Icon]</td>
<td>View Analysis</td>
<td>CTRL+INSERT</td>
<td>Hides/Shows the selected analysis.</td>
</tr>
<tr>
<td>![View Spectrum Icon]</td>
<td>View Spectrum</td>
<td>INSERT</td>
<td>Hides/Shows the selected spectrum (except raw data).</td>
</tr>
<tr>
<td>![Set Color Icon]</td>
<td>Set Color</td>
<td></td>
<td>Opens a palette of colors for manual allocation of a color to a spectrum.</td>
</tr>
<tr>
<td>![Default Color Icon]</td>
<td>Default Color</td>
<td></td>
<td>Resets previous color assignments.</td>
</tr>
<tr>
<td>![Set Selection Range Icon]</td>
<td>Set Selection Range</td>
<td></td>
<td>Selects a mass range in the Mass Spectrum Window.</td>
</tr>
<tr>
<td>![Clear Selection Icon]</td>
<td>Clear Selection</td>
<td></td>
<td>Clears the current mass range selection in the active data window.</td>
</tr>
<tr>
<td>![Box Selection Icon]</td>
<td>Box Selection</td>
<td></td>
<td>Toggles Mass Spectrum Window between Range Selection and Box Selection modes.</td>
</tr>
</tbody>
</table>
2.4.2.1 Copy

The **Copy** command, the corresponding icon of the toolbar, and the short cut (CTRL+C) are used to copy context dependent data into the clipboard. Afterwards the copied information may be pasted to other spectra or other applications, like Microsoft Office programs. According to the active flexAnalysis window the user can use Copy in the

- Analysis List Window (tree view), to copy the method (parameter and script) from the selected spectrum.
- Mass Spectrum Window, to copy the currently shown graphic, independent of the spectrum that is possibly selected in the tree view.
- Mass List Window, to copy the currently marked line(s) of the peak list.

2.4.2.2 Paste

The **Paste** command, the corresponding icon of the toolbar, and the short cut (CTRL+V) are only available for the Analysis List Window (tree view). With this button the just copied method (parameter and script) can be pasted to one or more other analyses. This feature is helpful if you have adjusted and saved a new method and want to apply it to several other spectra.

2.4.2.3 Paste Special

The **Paste Special** command is also only available for the Analysis List View and applies the method, which has been copied before. Since a method consists of parameters and a script the operator may want to transfer only parameters or only the script to other analyses. In this case the **Paste Special** command has to be used.

To test this feature, load three spectra in flexAnalysis. For the first one change some spectrum parameter (see section 2.4.7.5) and edit the script (see section 2.4.7.7). Mark the first spectrum in the tree view and choose **Copy**. Now mark the other spectra (CTRL key) and select **Paste** or **Paste Special** to paste the method content. Check the new settings for the two spectra in the parameter and the script editor.
2.4.2.4 Delete

The **Delete** command, the corresponding icon of the toolbar, and the short cut (DELETE) are context dependent.

In the tree view it is used to delete one or more processing steps (corresponds to the **Undo All Processing** command) but it does not delete the raw data file (no feature exists in the flex programs that can delete the raw data).

In the Mass List Window the **Delete** command is used to delete the selected lines of the peak list.

The command is not available for the Mass Spectrum Window.

2.4.2.5 Select All

The **Select All** command and the short cut (CTRL+A) are used to select the entire content of the active window, which is the Analysis List, the Mass Spectrum, or the Mass List.

2.4.2.6 Select None

The **Select None** command and the short cut (CTRL+D) refer to the active window and deselect everything that was previously selected.
2.4.2.7 View Analysis

The View Analysis command, the short cut (CTRL+Ins), and disabling the root checkbox in the tree view are used to display or remove one or more selected analyses from the Mass Spectrum Display.

![Analysis List]

Figure 2-19 Example for an analysis not displayed in the Mass Spectrum Window

The analysis, which is not displayed in the Spectrum Window remains in the Analysis List Window, however the corresponding root checkbox is cleared (see Figure 2-19).

2.4.2.8 View Spectrum

The View Spectrum command and the short cut (INSERT) are used to display or hide a selected spectrum or selected spectra in the Mass Spectrum Window.

Pressing the INSERT key a second time or selecting the related checkbox restores the display.

2.4.2.9 Set Color

The Set Color command opens a palette of colors (see Figure 2-20).

![Palette of provided colors]

Figure 2-20 Palette of provided colors

This command is used to change the color of one or more selected mass spectra. If only one spectrum is selected a white frame indicates the current color used for the selected mass spectrum. To change the color, simply click the desired color box.
2.4.2.10 Default Color

In flexAnalysis color assignments are performed according to a color hierarchy. Each color in this hierarchy has a unique value. Colors with higher values will be used prior to colors with lower values. The Default Color command assigns colors to the selected spectra, which are currently unused and have the highest scores in the color hierarchy.

2.4.2.11 Set Selection Range

The Set Selection Range command is used to select a mass range of the currently active spectrum within the Mass Spectrum Window, for example to run a peak picking process in this specific range. Additionally, an intensity range can be defined, when the button Range/box selection type is pressed.

In the dialog box minimal and maximal mass and intensity values can be entered to define the ranges. If only the mass range is requested, choose “Range selection”, to disable the intensity range.

![Range Selection dialog box](image)

Figure 2-21 Range Selection dialog box

2.4.2.12 Clear Selection

This command is used to clear a selected range in the Mass Spectrum Window.

2.4.2.13 Box Selection

This function determines the selection mode. If the box selection is switched on, both the mass range and the intensity range are selected. If the box is switched off only the mass range is selected.
2.4.3  Mass List Menu

<table>
<thead>
<tr>
<th>Mass List</th>
<th>Process</th>
<th>Calibrate</th>
<th>Annotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find</td>
<td></td>
<td></td>
<td>F5</td>
</tr>
<tr>
<td>Edit</td>
<td></td>
<td></td>
<td>[Ctrl]</td>
</tr>
<tr>
<td>Edit Direct</td>
<td></td>
<td></td>
<td>[Ctrl + Alt]</td>
</tr>
<tr>
<td>Clear</td>
<td></td>
<td></td>
<td>Shift+F5</td>
</tr>
</tbody>
</table>

- MS/MS List...
- Edit Mass Control List...
- Identify Background Peaks...
- Remove Background Peaks
- Distance in Mass List(s)...

Figure 2-22  Contents of the Mass List menu

The **Mass List** menu (see Figure 2-22) is composed of commands to work with mass lists.
Table 2-3  Features of the Mass List menu

<table>
<thead>
<tr>
<th>Feature button</th>
<th>Mass List menu commands</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find</td>
<td></td>
<td>F5</td>
<td>Automatically creates a mass list for the selected spectrum (spectra).</td>
</tr>
<tr>
<td>Edit</td>
<td></td>
<td></td>
<td>(De)Activates the Edit Mass List mode to edit the mass list of the selected spectrum.</td>
</tr>
<tr>
<td>Edit Direct</td>
<td></td>
<td>CTRL+ALT</td>
<td>Adds a ((m/z)-intensity)-pair to the peak list.</td>
</tr>
<tr>
<td>Clear</td>
<td></td>
<td>SHIFT+ F5</td>
<td>Clears the mass list of the selected spectrum.</td>
</tr>
<tr>
<td>MS/MS List</td>
<td></td>
<td></td>
<td>Opens a list with masses that have been selected from the MS peak list for manual or automatic LIFT measurement in flexControl.</td>
</tr>
<tr>
<td>Edit Mass Control List</td>
<td></td>
<td></td>
<td>Opens the Mass Control List Editor</td>
</tr>
<tr>
<td>Identify Background Peaks</td>
<td></td>
<td></td>
<td>Identifies background peaks on the basis of a Mass Control List that has to be selected here.</td>
</tr>
<tr>
<td>Remove Background Peaks</td>
<td></td>
<td></td>
<td>Removes the previously identified background peaks from the peak list.</td>
</tr>
<tr>
<td>Distances in Mass List(s)</td>
<td></td>
<td></td>
<td>Macro to compare spectra.</td>
</tr>
</tbody>
</table>

2.4.3.1  Find

The Find command, the corresponding icon of the toolbar, and the short cut (F5) are used to automatically generate a peak list for one or more selected spectra simultaneously.
Peak picking is performed according to the parameter settings of the current method (see section 2.4.7.5.1). The result is stored in the peak list and the mass spectrum is displayed with the detected mass peak labels.

Only one peak list can be displayed at a time. However, more than one list can be (re)calculated at once, by selecting the corresponding spectra with the mouse pointer in the Analysis List Window and simultaneously pressed CTRL key of the key board. Then activate the **Find** command for a peak finding in all the selected spectra.

### 2.4.3.2 Edit

It might become necessary to edit the peak list manually, because too many or too few peaks were detected during the automatic peak find procedure.

The **Edit** command and the corresponding icon of the toolbar are used for interactively adding or removing peaks, according to the respective peak detection algorithm.

This command displays the Edit Mass List pointers or , if the mouse pointer is positioned in the Mass Spectrum Window. The Add pointer is displayed when the mouse is placed near to a peak that currently has no annotation, whereas the delete pointer is placed next to an already detected peak in the spectrum.

If the new peak can be found using the Mass List Edit Method Parameter settings, the results are added to the peak list and a label appears in the display. To remove a peak from the peak list place the Delete pointer to the peak and press the left mouse button.

The Edit mode becomes also active when the mouse is inside the Mass Spectrum Window and the CTRL key is simultaneously pressed.

### 2.4.3.3 Edit Direct

The **Edit Direct** command, the corresponding button and the short cut (CTRL+Alt) are used to add an annotation manually. This pair of \( m/z \) / intensity data can be located at any position in the spectrum; the x-position is independent of a data point!

If this mode is activated, the mouse in the display will get a crosshair, to better see the mass and intensity values. Additionally you will get a ToolTip, which shows these information and the spectrum name (see Figure 2-23). This feature will be deactivated right after you have added an annotation manually.
An entry is added to the peak list, but only the columns for Mass, Intensity and Relative Intensity are filled. Because the peak annotation has not been created with a peak detection algorithm that would also calculate the other parameters, the coordinates from the m/z and intensity scales are used.

### 2.4.3.4 Clear

The Clear command, the corresponding button of the toolbar, and the short cut (SHIFT+F5) are used to clear the current mass list of the selected spectrum or spectra.

Select the spectrum/spectra in the Analysis List Window (if necessary with simultaneously pressed CTRL key) whose mass list(s) shall be cleared, click , or from the Mass List menu select Clear.

### 2.4.3.5 MS/MS List

The MS/MS List command works in connection with the Add to MS/MS List command that is available in the Mass List shortcut menu (see section 2.6.3). Masses from a MS peak list that have been added to the MS/MS List can be sent to flexControl for manual (Send to flexControl), or automatic (Append to AutoExecute Run) LIFT measurement (certainly also “Run method on current” can be used in flexControl).
To add masses from the peak list to the MS/MS list, right-click on the desired mass and choose Add Mass to MS/MS List. This can be done for several peaks from the same spectrum and for several spectra from the same target.

After masses have been added to the list, it can be opened with the MS/MS List command that then shows a dialog (see Figure 2-24). Peak masses and spot numbers are listed. The whole list can be cleared with the Clear button; single masses can be removed with the Delete button.

The button is used to send the whole list to the LIFT tab in flexControl. It is not necessary to have flexControl opened before. The masses of this list are then shown as selection list, so there is no need to type in the masses manually one by one.

Figure 2-24   MS/MS List with masses selected for LIFT measurement

To be able to use the button it is necessary that the MS spectra have been acquired either during an AutoXecute run, or manually with usage of the check box Add to run that is available in the Save As dialog in flexControl. Only these preconditions provide an AutoXecute run where the selected parent masses can be added to.
The button **Append to AutoXecute Run** is unavailable when no matching sequence can be found. It is not possible to create a sequence afterwards.

With this feature it is possible to do automatic LIFT measurement with masses that have been selected manually from a corresponding MS spectrum (in the AutoXecute sequence no MS measurement has to be specified).

The AutoXecute method and the flexAnalysis method, which are necessary for automatic MS/MS acquisition and post processing, are added automatically to the sequence due to settings performed in the flexConfigurator. For more information on the method assignment please see the flexControl user manual.

It is possible to add peaks from different spectra to the list. These spectra may have been acquired on different sample spots (see Figure 2-24). The only restriction is that they must have been acquired on the same target, which is identified by the so called carrier ID shown in the lower right corner of the flexControl GUI (e.g. T_0209519_0004835_36). Otherwise a message appears during spectra selection (see Figure 2-25). More information about this feature are given in the quickstart document Quickstart_PrecursorSelection.pdf.

The **Save As** button saves the MS/MS list to a .csv file for use by other applications (for instance, Microsoft Excel).

![.flexAnalysis]

*Figure 2-25* Information concerning different targets

**2.4.3.6 Edit Mass Control List…**

Opens the Mass Control List Editor, where you can define calibrant and/or background masses.
Mass Control List Editor

Mass Control List is a general term for lists that can be used as calibrant lists as well as background lists, by activating the respective check box. flexControl and flexAnalysis use the same lists, and, depending on the context from where a list is opened, either the column Calibrant is shown (Calibration dialogs), or the column Background (AutoXecute Method Editor), nevertheless the invisible information is still available. More details regarding the Mass Control Lists are given in the quickstart document Quickstart_MassControlLists.pdf.

2.4.3.7 Identify Background Peaks

The Identify Background Peaks command is used to identify background peaks in a spectrum on the basis of a Mass Control Lists (*.mcl) that has to be selected with this command.

To create or modify an existing background list, it has to be opened with the Mass Control List Editor (see section 2.4.3.6). Only masses that are marked as backgrounds in this list (see Figure 2-26) can be used to identify background masses in a spectrum. Masses can be marked as calibrants and/or as backgrounds. The Tolerance value is valid for both.

After a Background list has been applied to a spectrum, all peaks are marked with true or false in the column Bk.Peak that can be selected as additionally shown column in the peak list (see Figure 2-27).
The column **Bk.Peak** has been added to the Mass List Layout (**Mass List Layout** tab in the **Method Editor** (see section 2.4.7.5.4)).

Peaks, which are identified as background in the spectrum, become colored in the spectrum display, according to the chosen **Background Peak Label** color (see section 2.4.11.7.6). Additionally the display priority changes: if the label of a background peak overlaps with a label of a normal peak, the background label is omitted. But this does not change the currently available peak list! The Background filter feature might be useful for further processing, e.g. database searches in BioTools.

**Figure 2-27** Assignment of background peaks (true) in the column **Bk.Peak**

If, during an automatic run the background peak detection has been activated in the AutoXecute method, the information about which MassControlList is used is transferred to flexAnalysis. The name of the Background list is shown in the **Mass Spectrum Properties** dialog (see Figure 2-28).

**Figure 2-28** Background list information in the spectrum properties
2.4.3.8 Remove Background Peaks

The macro Remove Background Peaks is used to remove previously identified background peaks from the mass list of the currently active spectrum. To save the new peak list save the analysis! It is not possible, to remove background peaks without having identified them before!

To remove background masses automatically during an AutoXecute run, a special flexAnalysis method is necessary. Please contact the MALDI Software Support (maldi.sw.support@bdal.de) to get more information about this or see the pdf-file Quickstart_AnnotateExtern_cal.pdf that is available on the installation DVD in the folder Manual.

2.4.3.9 Distance in Mass List(s)

The macro Distance in Mass List(s) is used to search for specified fixed distances between peaks of one spectrum or of two spectra. It may be used for instance to search for salt adducts in MS spectra, amino acids in MS/MS spectra, or compare two ISD-spectra (Ion Source Decay) of the same sample but with different matrices in order to inspect differences in m/z of the fragment series.

The spectrum or the spectra to be inspected have to be selected in the Analysis List Window. At most two spectra can be selected. In case of more selected spectra the macro will be disabled!

If not yet available, a peak list from any of the two selected spectra has to be created. Otherwise a message appears (see Figure 2-29).

![Figure 2-29][1]

**Figure 2-29** No peak list available

The **Distance in Mass List(s)** macro opens a dialog (see Figure 2-30).
**AutoDistance dialog**

- **Distance**: Mass distance value to be searched for.
- **Tolerance**: The search tolerance. It can be specified in Da or ppm.
- **Spectrum/First Spectrum**: The drop down list contains up to two spectra. In case of two define the one that is used at first.
- **Calculate**: Starts to calculate and search for the selected distance.
- **Result**: List containing the calculations of flexAnalysis.
- **Save As**: This button opens the dialog to save the result as a CSV-file that different applications, e.g., Excel can easily import (see Figure 2-31).
Figure 2-31  Example of a Distance-in-mass-list result

2.4.4  Process Menu

Figure 2-32  Content of the Process menu

The Process menu (see Figure 2-32) is composed of various commands to process spectra.
Table 2-4  Features of the Process menu

<table>
<thead>
<tr>
<th>Feature button</th>
<th>Process menu commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Smooth Mass Spectrum" /></td>
<td>Smooth Mass Spectrum</td>
<td>Smooth selected spectra.</td>
</tr>
<tr>
<td><img src="image2" alt="Subtract Mass Spectrum Baseline" /></td>
<td>Subtract Mass Spectrum Baseline</td>
<td>Subtract baseline from selected spectra.</td>
</tr>
<tr>
<td><img src="image3" alt="Undo All Processing" /></td>
<td>Undo All Processing</td>
<td>Reverses all processing.</td>
</tr>
<tr>
<td><img src="image4" alt="Batch Process" /></td>
<td>Batch Process</td>
<td>Processes data in batch mode.</td>
</tr>
<tr>
<td><img src="image5" alt="Process spectra" /></td>
<td>Process spectra</td>
<td>Easy way of reprocessing spectra.</td>
</tr>
</tbody>
</table>

2.4.4.1 Smooth Mass Spectrum

The Smooth Mass Spectrum command and the corresponding icon of the toolbar are used to smooth the selected mass spectrum. The method parameter settings of the analysis are used for the smoothing operations (see Figure 2-69).

2.4.4.2 Subtract Mass Spectrum Baseline

The Subtract Mass Spectrum Baseline command and the corresponding icon of the toolbar are used to perform a baseline subtraction for the selected spectrum or spectra. The method parameter settings of the analysis are used for the baseline subtraction operation (see Figure 2-70).

2.4.4.3 Undo All Processing

The Undo All Processing command is used to return to the starting point before any processing took place. The raw data file (‘fid’-file) is loaded and displayed in the Mass Spectrum Window. Note that Undo All Processing does not cancel the possibly done calibration. If you want to apply additionally the original calibration constants use the command Apply raw calibration (see section 2.4.5.4).

2.4.4.4 Batch Process

The Batch Process macro is used to (re-)process spectra. The Batch Process dialog sends the spectra to the ProcessQueuer, which starts several flexAnalysis processes in
order to spread the spectra over the different invisible processes.

The maximum number of started flexAnalysis processes depends on your computer hardware. This approach saves processing time. Additionally it is now possible to configure the number of used processes in the Options part of the Batch Process dialog. The Batch Process command opens a dialog (see Figure 2-33).

![Batch Process dialog](image)

**Figure 2-33**  Example of a Batch Process dialog
- **From**: displays whether the shown spectra have been loaded with the button **Folder** or the button **AutoX Run**. This is important because only with loading spectra with the button **AutoX Run** it is possible to use different flexAnalysis methods, which is a major requirement for the recalibration of MS spectra.

- **Folder**: Select data file(s) for (re)processing with the **Open Multiple Spectra** dialog. The selected data path will be shown on top. The complete path(s) are displayed in the list. If spectra are loaded with the **Folder** button, you have to select a method with one of the **Browse** buttons below and start the batch processing afterwards.

- **AutoX Run**: Alternatively open an AutoXecute run to load the data that have been acquired with this run.

**Note** flexAnalysis methods must be assigned via the **RunEditor** sequence, it is shown with the information from **AutoXecute** that appears after loading the run. When no methods are selected in the AutoXecute run, i.e. the table column(s) **FA MS** and/or **FA MS/MS** are empty (because the FA methods have been selected in the AutoXecute methods) the spectra are not loaded but a message is displayed (see Figure 2-34).

![flexAnalysis Batch Process](image)

**Figure 2-34** No flexAnalysis method specified message

It is of course possible to add or change the methods selection in the **RunEditor** sequence even if the data are already measured and have been processed once. To do so just reload the sequence via flexControl in the AutoXecute Run Editor, add or change the flexAnalysis methods, and save the run, maybe with a new name (e.g. **xxx_for_FA_postprocessing.xml**) to have the original run still as backup. If the flexAnalysis methods are available in the run the spectra will be loaded in the flexAnalysis **Batch Process** dialog without problems. Please
remember to use a so-called calibration template when you set up an AutoXecute run that contains calibrant spots as well as sample spots.

- **Delete selected**: you can mark one spectrum in the list with the left mouse button. To select several spectra hold the CTRL or SHIFT key pressed. Click on the **Delete selected** button if you want to delete the marked spectra from the batch processing list.

- **Clear All**: The list of the prior loaded spectra can be deleted completely with the **Clear All** button.

- **Browse**: Each **Browse** button opens a dialog to select a method for the respective spectrum type. This method will be used for the batch process.

- **No. of FA Processes**: Enter the number of processes you want to use for the batch process. The maximum number of available processes is automatically shown with the start of the **Batch Process** dialog.

- **Mascot Search**: If spectra are loaded that have been sent during an AutoXecute run to BioTools for a Mascot search before, you may decide here if they should be sent to Mascot again after reprocessing in flexAnalysis, or not. If you only want to reprocess the spectra, deactivate this box.

- **Start**: Starts a batch process (see Figure 2-35). After a few seconds the estimated time is shown in the lower right corner. The Start button changes to Stop. This means if you click again on the button, the batch processing is stopped.

The **Start** button is unavailable when an AutoXecute run has been started before in flexControl, and the spectra processing that is triggered from this run is still in progress.

The other way round, that is when a batch process has been started in flexAnalysis, it is not possible to start an AutoXecute run, because only one program at a time is allowed to access the flexAnalysis processes. In flexControl a message appears (see Figure 2-35).
Figure 2-35  Run cannot be started

In case spectra could not be processed, the ProcessQueuer offers error messages and the faulty spectra are not deleted from the **Batch Process** dialog. With a double-click on one of these remaining spectra you can open it in flexAnalysis to investigate the reason for the error.
Additionally the Process Queuer pops up and shows more or less detailed information regarding the error. With a setting in the flexConfigurator it is possible to select between 2 log levels, standard and extended. The default setting is **Standard**. The Process Queuer log information are automatically saved in the file `C:\BDALSystemData\FAPQLog.csv`. 

**Figure 2-36**   **Error displayed in Batch Process dialog**
2.4.4.5 Process Spectra

The macro Process Spectra offers a simple method to (re)process MS-spectra without the necessity of writing a script. A dialog (see Figure 2-38) contains the most important processing features. They are the same as the corresponding commands in the different menus of flexAnalysis.

- **Calibrate (MS Spectrum)**: (see section 2.4.5).
- **Copy Calibration (MS Spectrum)**: (see section 2.4.5.2).
- **Replace Calibration (MS Spectrum)**: (see section 2.4.5.3).
- **Find Peaks**: (see section 2.4.3.1).
- **Send Spectra to ProteinScape**: (see section 2.4.11.3).

Select one or more analyses in the tree view activate the check boxes of one or more processings and click the **Start** button to starts the processing. A message appears reflecting the current state of the process.

The parameters that are used for processing can be set in the Parameter Editor for each analysis, respectively.

**Note** Before using the **Send Spectra to ProteinScape** command you must have installed the access to your ProteinScape Server! How to do this is described in the *ProteinScape User Manual*.

### 2.4.5 Calibrate Menu

![Calibrate Menu](image)

**Figure 2-39 Contents of the Calibrate menu**

The **Calibrate** menu (see Figure 2-39) is composed of various commands that have an effect on the calibration of the spectra.
### Table 2-5 Features of the Calibrate menu

<table>
<thead>
<tr>
<th>Feature button</th>
<th>Calibration menu commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Internal.png" alt="Internal" /></td>
<td>Internal</td>
<td>Opens the Calibration dialog.</td>
</tr>
<tr>
<td><img src="Copy.png" alt="Copy Calibration" /></td>
<td>Copy Calibration</td>
<td>Copies the calibration of a selected analysis into the calibration buffer of flexAnalysis.</td>
</tr>
<tr>
<td><img src="Replace.png" alt="Replace Calibration" /></td>
<td>Replace Calibration</td>
<td>Replaces the calibration of one or more analyses with the content of the calibration buffer.</td>
</tr>
<tr>
<td><img src="Apply.png" alt="Apply Raw Calibration" /></td>
<td>Apply Raw Calibration</td>
<td>Changes the calibration constants to the ones that came with the raw data.</td>
</tr>
</tbody>
</table>

#### 2.4.5.1 Internal

If you want to adjust calibration parameter for a new calibration of a mass spectrum of a selected analysis use the Internal command, or the corresponding icon of the toolbar. The Internal Mass Spectrum Calibration dialog (see Figure 2-40) opens. During the calibration particular masses of the selected mass spectrum are assigned to corresponding reference masses of the loaded calibration list.

Calibration is possible for MS spectra and LIFT spectra, the latter must have been created with ≥ flexControl 3.0! Old LIFT spectra and FAST spectra cannot be recalibrated in flexAnalysis because the MS/MS calibration was part of the acquisition system and thus part of the acquisition method in flexControl.

flexAnalysis offers three MS calibration strategies:

- Interactive Calibration, automatic or manual, using calibration lists (MCLs).
- Smart, that is an easy-to-use calibration procedure for optimum results. The program reappraises the statistical frequency of occurrence of calibrants.
- Statistical Peptide calibration for peptide spectra.

and two LIFT calibration strategies:

- iCal uses ImmoniumIons.mcl as calibration list.
- Statistical LIFT for peptide LIFT spectra
The calibration strategy is saved in the flexAnalysis method and spectrum method, but can also be changed.

Figure 2-40  Mass Spectrum Calibration dialog – Calibration Strategy “Interactive”

►► To perform a manual internal calibration of a spectrum

1. Load the spectrum and open the Internal calibration dialog.

2. Select the Mass Control Lists that matches to the spectrum mass range and contains some masses that are also available in your spectrum.

3. Click Automatic Assign or assign masses from the display manually to masses from the MCL.

4. Click the button Calibrate to create the new calibration.

5. Click the button OK to accept the new calibration and close the dialog.

The commands Copy Calibration (see section 2.4.5.2) and Replace Calibration (see section 2.4.5.3) can then be used to recalibrate unknown sample spectra.
Interactive Calibration

The calibrant list shows names and masses of known substances, the corresponding masses found in the currently active spectrum, and the error in ppm and in Dalton. Interactive Calibration can be done automatically with the button or manually with click in the list on one calibrant followed by a click in the spectrum left of the corresponding peak. Masses of the peak list are then entered in the calibration list and the error is re-calculated with each new assignment. The error in Dalton is calculated with \( \frac{(\text{current mass} - \text{reference mass})}{\text{reference mass}} \), the error in ppm is calculated with \( \frac{(\text{current mass} - \text{reference mass})}{\text{reference mass}} \times 10^6 \). To help you to perform a good calibration, a box with hints might appear. E.g. it will ask you to assign more peaks or to cover a larger mass range.

Mass Control List Selection

This pull down menu contains the available calibration lists (MCLs). Only lists with at least one mass marked as calibrant are offered. The calibrants of the selected list are displayed in the box below.

Edit Button

Applying this button opens the Mass Control List Editor (see Figure 2-41), as does the button on the Calibration tab (see Figure 2-72) in the Parameter Editor (see section 2.4.7.5.3). MCLs can be changed and created with this editor. For more information on how to use and create MassControlLists see Quickstart_MassControlLists.pdf available on the Compass for flex installation DVD.
Figure 2-41  Mass Control List Editor

Automatic Assign Button

Peaks from the peak list are automatically assigned to the reference masses; a new fit result and errors are calculated but not yet applied to the spectrum. If no peak list is available, this is automatically created before the assignment. The peak finder algorithm used for automatic calculation is the one currently selected in the processing parameter editor, section Mass List Find (see section 2.4.7.5.1).

Calibrate Button

With a click on this button the new fit result, calculated with manual assignment or the button Automatic Assign is applied to the spectrum (it is moved in the display).

Undo Button

After the new fit result has been applied with Calibrate it can be canceled with the Undo button. The original calibration, currently saved in the spectrum is applied again and peaks are re-annotated.
Clear Assigned Button

This button deletes the assignments from the calibration list; it does not affect any existing calibration.

OK and Cancel Buttons

After a calibration has been done, the dialog can be closed with these buttons. OK means "calibrate and close", so even if the Calibrate button has not been applied the calibration is accepted. Cancel means "undo and close", i.e. even if the calibration has been applied with Calibrate before, it is not accepted.

Zooming During Manual Assignment

For manual assignment of masses to reference masses it is necessary to click in the spectrum left to the peak of interest. Therefore it is helpful to zoom automatically the respective mass range corresponding to the selected reference mass. It is possible to choose between some relative and absolute zoom ranges.

Note If an entry in the list box is selected, you can use the mouse wheel to select the next reference mass (or to go back to a previous one). This simplifies the manual assignment.

Peak Assignment Tolerance

The tolerance defines a mass interval that is used for the calibrant assignment. If the difference between a reference mass and a peak in the peak list is smaller than the tolerance, the peak is assigned to the calibrant. If more than one peak of the peak list fits this criterion the peak with the smallest mass difference to the calibrant is assigned to the calibrant.

Calibration Fit Order

Selecting this option performs a linear, quadratic, cubic enhanced or linear correction calibration calculating of the coefficients $c_0$, $c_1$ (and $c_2$ and $c_3$). For linear calibrations $c_2$ and $c_3$ are set to zero; for quadratic calibrations $c_3$ is set to zero.
**Properties Button**

The **Properties** dialog shows the current state of the calibration and some general calibration information. If spectra have been acquired with a flexControl HPC method the check box **High Precision Calibration applied** at the bottom is activated (read-only check box).

![Calibration Properties](image)

**Figure 2-42**  Calibration Properties dialog

**Result Information**

Below the calibration list three result fields are shown: the number of used calibrants, the standard deviation before and standard deviation after the last calibration fit.

If no peaks are found during the automatic peak assignment the following message appears where possibilities are offered to correct the calibration. A good starting point is to check that the selected MCL really matches to the mass range of the spectrum that should be calibrated. Also, the selected tolerance is often too small for a special data set. This happens when the flexControl method has not been calibrated for some time, so the
spectra are acquired with a bad calibration (mass shift) that cannot be compensated with the chosen flexAnalysis tolerance.

![Automatic calibrant assignment failed.](image)

**Figure 2-43** Message to repeat automatic assignment with different conditions

The information message **Assign more peaks** means that the currently chosen calibration mode (linear, quadratic, cubic enhanced) needs more calibrants to be able to calculate a new calibration.

![Assign more peaks](image)

**Figure 2-44** Assign more peaks message

The information message regarding the mass range coverage means that the currently already assigned masses do not cover the acquisition mass range of the spectrum.

![Mass range coverage message](image)

**Figure 2-45** Mass range coverage message

Both messages can be ignored as long as you go on with assignment of new calibrants.
Smart Calibration

![Graphical User Interface (GUI)](image)

**Figure 2-46**  Mass Spectrum Calibration dialog – Calibration Strategy “Smart”

If the option **Smart Calibration** is selected the calibration dialog looks as shown in Figure 2-46.

**SMART** is an "intelligent" calibration strategy, which significantly improves the identification success and the scores for PMFs (Peptide Mass Fingerprints). SMART calibration requires project specific mass control lists for calibration and background peak exclusion. Such lists are generated with Bruker ProteinScape software or, on individual customer request, by the Bruker Software support (maldi.sw.support@bdal.de). Common mass control lists can also be used as smart calibration lists if they contain more than six calibrants.

The SMART calibration is an iterative process which takes the following points into account:

- the number of calibrants found in the respective spectrum,
- the likelihood of these calibrants appearing,
- the accuracy of the mass values, as well as their distribution over the required calibration mass range.
The project dependent mass control lists do not only include the peptides, whose sequences and theoretical masses are known (e.g. trypsin autolysis products, and keratin fragments), but normally a large number of background peaks. Their sequence is not known, and their masses are determined by the average obtained from a large number of well calibrated spectra obtained during such a project. Such background peaks are project specific and are very dependant on sample preparation (digestion method, staining method and preparation).

**Statistical Peptide**

The third calibration strategy, Statistical Peptide, is only useful when peptide spectra are calibrated.

**Figure 2-47**  
Mass Spectrum Calibration dialog – Calibration Strategy “Statistical Peptide”

Statistical Peptide is a so-called self-calibration of TOF peptide spectra. It is a powerful tool, especially in cases, where no internal calibrants are known.

**Note**  
A statistical calibration needs no calibrant list!

This strategy is based on the fact that the monoisotopic masses of peptides are distributed in a very regular way, at least in the mass range, which is used for protein digest measurements. The masses accumulate around masses \( m_{\text{mean}} \) at a distance of approximately 1.00048 Da. The masses \( m_{\text{mean}} \) are used as calibrants for all peaks in the mass list in a statistical calculation of the new calibration constants.
2.4.5.1.1 **Golden Rules for Statistical Calibrations**

Statistical calibrations are applicable for peptides only. Under good conditions a mass error of 20 - 40 ppm can be reached.

The more peaks are available in the mass list and the better the distribution of these peaks over the mass range of interest is, the better is the result of the statistical calibration. As a rule of thumb about 20 peptide peaks are needed to obtain a meaningful result.

The maximum mass error of the peaks must not exceed about 0.4 – 0.5 Da (500 ppm at 900 Da). At about 0.5 Da the algorithm cannot decide which mass is concerned. This can lead to an incorrect calibration of one Da!

If you feel certain that the external calibration of the given spectrum is significantly better than 500 ppm you can reduce the peak assignment tolerance accordingly. This can slightly enhance the performance of the statistical calibration.

Strong matrix cluster peaks between 700 and 1500 Da can affect the quality of the statistical calibration results. This happens because the stoichiometric composition of matrix clusters and peptides are strongly different.

**iCal**

The fourth calibration strategy, iCal, is used for the recalibration of LIFT spectra from peptides.

![iCal Mass Spectrum Calibration dialog – Calibration Strategy “iCal”](image)

**Figure 2-48** Mass Spectrum Calibration dialog – Calibration Strategy “iCal”
The calibration is based on a mass control list (ImmoniumIons.mcl) containing the masses of abundant immonium ions of peptides (i-type ions). These are internal fragments of single amino acids residues.

**Note** Not every immonium ion will be present in every Lift spectrum!

During calibration routine, the calibrants are matched to the annotated signals and a new calibration is applied to the spectrum.

**Note** Manual peak selection is not possible!

The iCal strategy can be used automatically together with the flexAnalysis method SNAP_full_process_calibrate_ical.FALIFTMethod.

For iTRAQ8plex samples, a special mass control list is available (iTRAQ8plex_iCAL.mcl) containing the 8 reporter ions and the mass of the complete label. These ions are very abundant peaks in the LIFT spectra and well suitable for iCal.

**Note** For iTRAQ samples use the iTRAQ8plex_iCAL.mcl and not the ImmoniumIons.mcl!

### Statistical LIFT

The fifth calibration strategy, Statistical LIFT, is only useful when LIFT peptide spectra are calibrated. For details read the Statistical Peptide chapter above.

![Internal Mass Spectrum Calibration](image)

**Figure 2-49** Mass Spectrum Calibration dialog – Calibration Strategy Statistical LIFT
2.4.5.2  Copy Calibration

With this command the calibration constants of a spectrum can be copied into the clipboard. Afterwards they can be pasted to another analysis.

1. Select an analysis in the Analysis List Window.

2. Select **Copy Calibration**. The command copies the calibration of the selected analysis into the calibration memory of flexAnalysis. Afterwards it can be pasted to other analysis/analyses. Only MS fingerprint calibrations can be copied and transferred into the calibration buffer.

2.4.5.3  Replace Calibration

The **Replace Calibration** command transfers the calibration from the calibration memory to the selected analyses.

Precondition: A TOF calibration, i.e. the constants $c_0$, $c_1$, and $c_2$ of an analysis have already been copied into the calibration memory of flexAnalysis (copy calibration).

1. Select one or more analysis/analyses in the Analysis List Window.

2. Select Replace Calibration. The calibration constants are transferred.

Before a calibration is transferred from one analysis to another one, it is checked whether the high voltages of the ion sources 1 and 2, the lens and reflector voltages of the two analyses are identical within a range of 0.01 V. If this is not the case a warning message appears. Press “No”, if you don’t want to transfer the calibration and “Yes”, if you want to apply the external calibration despite of the mismatch of the calibration voltages.

The latter two sections describe the manual way to do a calibration and transfer it to a set of sample spectra. This can also be done automatically (within an AutoXecute run) with two pre-installed methods: CalibratePeptideStandards.FAMSMethod and ExternalCalibration.FAMSMethod.

The first one is applied to spectra acquired on a calibration sample; the script of this method performs the calibration process and copies the new calibration constants. The second method is applied to spectra that are acquired on the sample spot after (!) the calibration measurement. The script cares for the transfer of the newly calculated calibration constants.
2.4.5.4 Apply Raw Calibration

The Apply Raw Calibration command is used to reset the calibration to those values, which were originally stored during the acquisition in flexControl. The peak list will be recalculated. This command is only available for MS spectra.

After applying and before executing this command a warning message appears (see Figure 2-50).

![Warning before applying the raw calibration](image)

Figure 2-50 Warning before applying the raw calibration

2.4.6 Annotation Menu

The Annotation menu (see Figure 2-51) is composed of various commands that allow you to attach specific annotations to mass spectra, to modify these annotations and to remove them again if you do not want them to be saved with the respective mass spectrum.

![Content of the Annotation menu](image)
Table 2-6 Features of the Annotation menu

<table>
<thead>
<tr>
<th>Feature button</th>
<th>Method menu commands</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annotate</td>
<td>Annotate</td>
<td>ALT</td>
<td>Activates the Annotation mode.</td>
</tr>
<tr>
<td>Clear</td>
<td></td>
<td></td>
<td>Deletes all annotations from the display and from the Sequence List.</td>
</tr>
<tr>
<td>Show mass differences</td>
<td>Show mass differences</td>
<td></td>
<td>Hide/display mass errors relative to theoretical mass differences</td>
</tr>
<tr>
<td>Preview Assignments</td>
<td>Preview Assignments</td>
<td></td>
<td>Spider web mode: screen for all possible next peaks automatically</td>
</tr>
<tr>
<td>Edit Building Blocks</td>
<td>Edit Building Blocks</td>
<td></td>
<td>Opens the Building Block Editor</td>
</tr>
</tbody>
</table>

An annotation is attached to one (single-point annotation) or two (difference annotation) selected data points and is defined by its position in terms of the data coordinates (intensity and mass). Therefore, when the display range is changed, an annotation moves along with its associated mass spectrum. Annotations can be attached to any peak of the peak list.

Each annotation consists of a value or text entry and a line marker that indicates the m/z value(s) the respective annotation relates to.

Different annotation types are available depending on the kind of data you wish to annotate. Mass spectra peaks can be annotated with their corresponding m/z, values of m/z difference, building block information or text.

2.4.6.1 Annotate

The Annotate command, the corresponding icon of the toolbar and the shortcut (Alt) are used to activate the Annotation mode. The toolbar is expanded with Annotation features (see Figure 2-52).

![Annotation toolbar](image.png)

Figure 2-52 Annotation toolbar
These toolbar features are pre-installed, some others, concerning the annotation font and orientation, can be additionally selected using the **Customize Toolbar** (see section 2.4.11.6).

This drop down box offers all available Building Block Sets (the sets can be edited with the **Building Block Editor**). Select a set from the list that possibly contains building blocks that match to the currently selected spectrum.

The **Building Block Search Tolerance** has to be entered manually; it is possible to change between Dalton and ppm. The Tolerance is used for the preview assignment feature (see section 2.4.6.4).

The field **Annotation Text** can either be filled manually with any text (that is then transferred into the display) but it is also filled automatically with the Building Block information that belongs to the Annotation that is just activated in the display (mouse click). Depending on the selection of the **Abbreviation** box (see below), the full name, symbol or abbreviation of the Building Block is shown.

The selection in the **Abbreviation** box for Building Blocks determines whether the Symbol, Abbreviation or the Full Name of the currently activated Building Block is shown in the display and in the **Annotation Text** field (see Figure 2-53).
The font and font size, as well as the position and orientation of the annotations can be determined with these features. The color of the **Annotation** label can be changed via the Tool menu entry **Colors**.

### 2.4.6.2 Clear

The **Clear** command and the corresponding icon of the toolbar are used to delete all Annotations from the spectrum display, as well as the possibly resulting sequences from the Sequence list.

### 2.4.6.3 Show Mass Difference

The **Show Mass Difference** command and the corresponding icon of the toolbar are used to show mass differences additionally to the respective Annotation (name, symbol or abbreviation) in the display. This value shows the mass difference between an assigned building block and the actual mass difference between the two chosen peaks.
2.4.6.4  Preview Assignments

The **Preview Assignments** command and the corresponding icon of the toolbar offer a preview on all possible distances (to higher and lower masses) depending on the entered search tolerance that can be calculated for one (!) starting peak together with the selected Building Block set (see Figure 2-55). To see the preview for one mass:

- make sure that you have a peak list,
- activate the Annotation mode, and activate the Preview Assignments button,
- click on a peak in the spectrum display and keep the left mouse button pressed.

The matching Building Blocks will be shown. You can choose one of these and release the mouse button to get this annotation.

![Figure 2-54](image1)

**Figure 2-54**  Annotation with and without Mass Difference

![Figure 2-55](image2)

**Figure 2-55**  Example for possible assignments for the peak 517.18 Da
2.4.6.5 Edit Building Blocks

The **Edit Building Blocks** command is used to start the Bruker Daltonics **Building Block Editor** application which allows you to view and edit the currently available building block sets to be used to automatically interpret m/z differences.

Selecting this command starts the **Building Block Editor** and loads the first of the alphabetically ordered building block sets shown in Building block sets. The building blocks contained in this set are listed in Building Blocks along with their Full name, Abbrev(iation) and chemical Formula. Additionally, the Symbol is shown which appears in the data window when the Annotation mode is active.

Various Bruker Default building block sets are available. A `<BrukerDefault>` appendix to the building block set name indicates these. You cannot alter or delete them. However, you can set up user specific building block sets by copying such a Bruker Default set to a new file name and then modifying the copy according to your own requirements or by creating a completely new building block set.

![Building Block Editor](image)

**Figure 2-56** Building blocks contained in the loaded building block set
2.4.7 Method Menu

Figure 2-57 Contents of the Method menu

The Method menu (see Figure 2-57) is composed of various commands to configure method parameters.
Table 2-7  Features of the Method menu

<table>
<thead>
<tr>
<th>Feature button</th>
<th>Method menu commands</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td></td>
<td></td>
<td>Opens a processing method.</td>
</tr>
<tr>
<td>Save</td>
<td></td>
<td></td>
<td>Saves the open processing method with the same file name if not write protected.</td>
</tr>
<tr>
<td>Save As</td>
<td></td>
<td></td>
<td>Saves the open processing method with a new file name.</td>
</tr>
<tr>
<td>Run Script</td>
<td></td>
<td>F2</td>
<td>Runs the Sax Basic script of the open processing method on the selected analysis.</td>
</tr>
<tr>
<td>Edit Parameters</td>
<td></td>
<td>ALT+F2</td>
<td>Opens the method parameter editor.</td>
</tr>
<tr>
<td>Edit Processing Parameters</td>
<td></td>
<td>SHIFT+F2</td>
<td>Opens the Processing Parameter Editor.</td>
</tr>
<tr>
<td>Edit Script</td>
<td></td>
<td>CTRL+F2</td>
<td>Creates or edits the Sax Basic script that belongs to the open processing method.</td>
</tr>
<tr>
<td>Select Default</td>
<td></td>
<td></td>
<td>Opens a dialog to select automatically attached default processing methods.</td>
</tr>
</tbody>
</table>

Methods are central elements in flexAnalysis. They determine the processing of the analysis. An analysis is always associated with one method. This assignment takes place during the load process and depends on several criteria.

First of all it depends on whether the analysis has already been processed and saved with flexAnalysis or not. If the analysis has once been saved with flexAnalysis a file called analysis.FAMethod is available (next to the fid file in the spectrum tree) that contains all method settings (parameter and script) that were active at saving time. This file is loaded when the analysis is opened again. In this case the spectrum sample name is shown in the status bar at the bottom of the GUI.

If the analysis has never been saved with flexAnalysis before the program checks whether the acquisition program flexControl (Save As dialog) or AutoXecute (Processing tab or FA MS/FA MSMS column) has specified a flexAnalysis method after the acquisition. In this case this method is assigned. If the assignment fails either because the method is broken or does not exist the Default method (see section 2.4.7.8) is loaded, because it is
not possible to open a spectrum without a method. In all these cases the name of the method is shown in the status bar at the bottom of the GUI, at least as long as the script is running.

In some cases the assignment of the Default Method may fail, too. Then so called Default Values (and an empty script) are loaded to have access to the data and to assign working methods manually. This failure is shown with the information <Default Values> in the status bar at the bottom of the GUI.

A flexAnalysis method consists of two parts, the method parameters (see section 2.4.7.5)) and the method script (see section 2.4.7.7). The method script determines the sequence of processing procedures performed with your analysis, while the method parameters configure each processing procedure.

**Note** The peak list layout is also a method parameter.

If an analysis that has never been processed in flexAnalysis before is opened the method script is executed automatically and the **Script in progress** dialog is shown (see Figure 2-59).

To get more information on the flexAnalysis method concept please refer to the Quickstart flexAnalysis Method Concept.pdf.

### 2.4.7.1 Open

The **Open** command and the corresponding icon of the toolbar are used to open the **Open flexAnalysis Method** dialog (Figure 2-58) to choose a new flexAnalysis method. The new method replaces the previous one. The name of the current processing method is displayed in the status bar of the GUI (see section 2.3) title bar of the **Method Parameters** dialog box (see Figure 2-60), that appears when selecting the **Edit Parameters** command from the Method menu, as well as in the title bar of the **Method Script Editor** (see Figure 2-77) and in the status bar of the GUI. Here it is displayed as long as the analysis has not been saved.
How to assign a method

There are different ways to assign a new method to a selected analysis. This may be required if it is necessary to use a method that is different to the current method settings.

Assigning a method with the open command:

1. Select the analysis that shall obtain a new method.

2. Click the button ▶

-or-

1. From the Method menu, select Open.

2. Select the method you want to apply.

3. Click Open.
Attaching a processing method of another analysis with copy and paste (see section 2.4.2):

It is not required that this method exists in the flexAnalysis methods directory.

1. Mark the analysis whose method you want to attach in the tree view.

2. Right-click the selection and select **Copy** or click the button .

3. Mark the analysis that shall obtain a new method in the tree view.

4. Right-click the selection and select **Paste** or **Paste Special** or click the button .

2.4.7.2 **Save**

The **Save** command, or the corresponding icon of the toolbar are used to save changed method settings to the same file name. This overwrites the original (not write protected) method. If the opened method has been changed but not saved, it is shown by the '(modified)' indicator, a *-symbol, which is shown in the title bar of the **Method Parameters** dialog box or in the **Script Editor**. If a modified method is not saved the current parameter settings for an analysis will be saved when this analysis is saved. For spectra that are available in the XMass format the file **Analysis.FAmethod** is created in the analysis tree. Spectra that are available in the new container format also have a method assigned, i.e. parameters and a script, but it cannot be found on the hard drive.

Selecting the **Save** command removes the '(modified)' indicator previously appended to the title bar of the **Method Editor**.

**Note**  If the original method is write-protected the **Save** command is not accessible and the **Save As** dialog opens.

2.4.7.3 **Save As**

The **Save As** command is used to create a new processing method by saving a changed method to a new or already existing file name. Enter a new or select an existing processing method name in the appearing dialog.

The new file name will be displayed in the status bar at the bottom of the GUI and in the title bar of the corresponding **Method Parameters** dialog box instead of the previous method name.
2.4.7.4  Run Script

The Run Script command, the corresponding icon of the toolbar, and the short cut (F2) are used to run the Sax Basic script that belongs to the currently loaded method of the selected analysis.

The running of the script is indicated on a progress indicator (see Figure 2-59).

![Method Script in Progress](image)

Figure 2-59  Running method script

The script processes the spectrum according to the particular processing operation(s) and parameters defined in the script and the Parameter Editor, respectively.

To view a script before running, the flexAnalysis Script Editor (see section 2.4.7.7) can be opened. The script can then be started directly from here.

2.4.7.5  Edit Parameters

The Edit Parameters command, the corresponding icon of the toolbar, and the short cut (Alt + F2) are used to open the Method Parameters dialog for the spectrum that is currently marked in the tree view. According to the selected kind of spectrum (MS, LIFT, and FAST) the editor offers a variable number of tabs with respective features.

Note  All features contained in this section are method parameters. If one parameter is changed and you want to use it in future, you have to save the method. When only the currently active spectrum is saved, the settings are not automatically available for other spectra! If you want to use a special set of parameter for all your spectra, you have to create a new method (and save it with a new name).

2.4.7.5.1  Process

The currently active parameters for peak finding, smoothing and baseline subtraction can be seen via the Process tab as Active Settings. You may select a different parameter
set from the drop down box or create own sets and save them with new names. When one of them is selected here its content will naturally remain selected when you click Apply or close the Parameter Editor with OK, only its name changes to Active Settings and the content of the set becomes part of the method (nevertheless don't forget to save the method afterwards!). This means that the name of a previously selected parameter set will not be shown anymore, but the parameters are still active!

![Parameters Only](image)

**Figure 2-60** Process tab

Since Compass 1.2 for flex, i.e. flexAnalysis 3.0 and flexControl 3.0 the peak detection algorithms as well as processing settings like baseline subtraction and smoothing are defined in Processing containers (*.prp) that are edited via the Processing Parameter Editor (see Figure 2-61). These parameter containers can be created, edited and used from flexAnalysis, flexControl and AutoXecute. Detailed information can be found in the corresponding Quickstart ProcessingParameterMethods.pdf. For flexAnalysis methods it is important to know that the METHOD has to be saved when parameters have been changed, even the prp-file is already saved!

►► **The workflow for changing peakfinder settings for a flexAnalysis MS method is:**

1. Load any MS spectrum.
2. Load any MS method.
3. Open the Parameters Editor.
4. Click Edit to open the prp editor, change for example the Signal/Noise value.
5. Close the prp editor.
6. Close the Parameters Editor by clicking OK.
7. Save the method using the Save (As) option in the Method menu.
Note Even when a processing parameter container (prp) has been saved with a name, this name won't be shown when you open the Parameters dialog of a method again. No matter what you have entered, the only term that you will see is Active settings. Of course your settings are stored and used, but they lost their name and became part of the flexAnalysis method. You don't have to select the parameter set again!

Note It is not necessary and in a lot of cases also not recommended to use the same parameter container in flexControl and flexAnalysis, since both programs do different things (acquisition/optimization vs processing).

Mass List - Find

The flex programs support three different detection algorithms: Centroid, SNAP, and Sum. These are used to detect mass peaks, calculate the corresponding m/z values and many other peak parameters, such as intensity or resolution.

![Processing Parameter Editor - Mass List Find](image)

Figure 2-61 Processing Parameter Editor - Mass List Find

Any peak finder is optimized for a specific task. In most cases if the elementary composition is known (see Figure 2-64), it is recommended to use SNAP for detection of groups of isotopic peaks. Centroid is often used in case of protein spectra and benefits in defining mass accuracy. The Sum Finder is used for time critical applications.

The following four parameters are the same for all algorithms:
Signal to Noise (S/N) Threshold

The S/N is defined as the height of the mass peak above its baseline relative to the standard deviation of the noise, i.e. peak height / (3 x σ) (σ: standard deviation of the noise). The higher the threshold is the less peaks are found. However, if the selected value is too small, noise may be regarded as peaks. The recommended S/N range varies from 3/1 to 10/1. In case of 10/1 you can be sure to have eliminated nearly all the noise.

Relative Intensity Threshold

The Relative Intensity Threshold is a level in percent referring to the base peak, which is the largest peak in the spectrum. In cases, where it is not clear, whether the base peak refers to the sample or not, the recommended value for this threshold is 0 (zero).

Minimum Intensity Threshold

A peak must have at least this intensity to be detected and annotated from the peak finder. It is useful for example for Imaging runs where the fuzzy control is de-activated and spectra that only consist of electronic noise are acquired. They show a flat baseline and some spikes with small intensities that will be annotated and will distort the picture. The Minimum Intensity Threshold allows ignoring these.

Maximal Number of Peaks

This is the maximal number of peaks that shall be detected by any of the three detection algorithms. In case of SNAP this value is an additional filter regarding the Quality factor, for all other algorithms the peaks with the highest intensity will be selected.

Additionally each peak detection algorithm has also some special parameters that can only be adjusted, if the respective algorithm has been chosen from the drop down list.

Peak Detection Algorithm Centroid

The peak finding mechanism for Centroid (see Figure 2-62) uses the first and second derivative to detect a peak. For the peak position a specific cut off level above the baseline, Percent Height, has to be specified. A value around 80% is recommended. When using Centroid the baseline has to be subtracted temporary. It is added afterwards. This baseline subtraction algorithm has to be selected on the Mass List Find tab.
Note The algorithm chosen here is not used for the “real” baseline subtraction, which has to be specified via Processing Baseline Subtraction.

Other special **Centroid** parameters are:

- **Peak Width**
  - The parameter **Peak Width** is not a threshold but an expectancy value. Peaks having this width are expected in the spectrum and will be accepted. If the width value is set too high, small peaks will be regarded as noise.

- **Height**
  - This value determines the upper part of the peak that is used to locate the peak position on the x-axis, i.e. $m/z$. If the separated peak area is symmetric the peak position will be found centric, otherwise the maximum is shifted.

![Processing Parameter Editor (Mass List Find: Centroid)](image)

**Figure 2-62** Processing Parameter Editor (Mass List Find: Centroid)
Peak Detection Algorithm SNAP

SNAP — Sophisticated Numerical Annotation Procedure — (see Figure 2-63) searches for known patterns in the measured spectrum and performs its own internal baseline correction and noise determination. Note: this internal baseline correction and noise determination is only a calculation. This means if this is not defined explicitly; the peaks will only be labeled.

With SNAP groups of peaks are detected in high throughput proteomics, e.g., for identification of isotopic patterns and exact calculation of the monoisotopic masses. Monoisotopic masses are the basis for database search and DeNovoSequencing, which allows elucidating structure and sequence of a particular peptide if database search for MS/MS data failed.

SNAP calculates the isotopic distribution of a given mass, charge and mean molecular constitution and uses the resulting isotopic pattern for a nonlinear fit that delivers the monoisotopic mass in the end.
Quality Factor Threshold

The parameter **Quality Factor Threshold** describes the reliability of a peak. It is a composition of peak intensity and consistency with known isotopic patterns. It is not possible to give a recommendation for this value; the best is to have a look on it in some representative spectra and find out the size.

SNAP average composition

The drop down menu **SNAP average composition** allows selecting a composition. Existing compositions can be modified; compositions of other averaged substance classes can be added. Modifications of Bruker defaults have to be saved to a different name.
Figure 2-64    List of SNAP average compositions

For peptide applications a composition called **Averagine** is defined. The conceptual meaning of the word Averagine (see Figure 2-65) and the term C 4.9384 N 1.3577 O 1.4773 S 0.0417 H 7.7583 is the averaged composition of molecules of the 21 amino acids corresponding to their abundance ratio. This creation is denoted the first Building Block and is always located in the first row (see Figure 2-65).

To edit a Building Block click ![Edit](Edit.png).

Figure 2-65    The pre-installed average composition Averagine

SNAP uses this average composition as often as it is necessary for approximation to the molecule under investigation. If a second composition is defined that is a mass existing only once in a monomer, SNAP uses this one exactly once for mass determination. The Second Building Block is always located in the second row (see Figure 2-65).

**Fragment Peak Width**

This parameter is used to confine a peak to a particular width thus excluding broader peaks from the peak list.

**SILE Mass Difference(s) (H –L)**

Enter one or more values (separated by a semicolon) to define the mass difference between the Heavy (H) and Light (L) isotopes of the labeling reagent.
The SILE mass difference(s) defines the m/z distance between the two or more labeled forms. E.g. for 18^O digest labeling it would be one and two times

\[ m/z (18^O) - m/z (16^O) = 2.004 \text{ and } 4.008. \]

The knowledge about the SILE mass differences is used for an improved S/N threshold and the internal judgment of the presents of overlapping monoisotopic peaks.

**SILE Partner SN Threshold**

The SILE Partner S/N Threshold allows the definition of a second S/N threshold which is checked for SILE partners. If there are two SILE partners only one has to match the normal threshold. For the second partner it is enough if it is large enough to match the SILE partner SN threshold. This gives a better dynamic range for the observable regulation without adding too many noisy peaks.

**Peak detection algorithm Sum**

The Sum peak finder (see Figure 2-66) uses a time-saving approach while calculating so-called pseudo derivatives instead of real derivatives as known from Centroid. If the pseudo slope exceeds a certain threshold, a peak is regarded as peak. The Sum algorithm makes internal use of the configurable baseline correction and noise calculation to select peaks and to calculate signal-to-noise ratios. The configurable parameters are explained with the other algorithms.
**Figure 2-66**  Processing Parameter Editor (Mass List Find: Sum)

**Mass List Edit**

**Figure 2-67**  Mass List Edit – use Mass List Find as sensitive as possible

The main difference between the Mass List Edit tab and the Mass List Find tab is the checkbox **Use specific parameters for peak picking**. If this checkbox is not selected
(see Figure 2-67) all parameter settings that are currently selected in **Mass List Find** are used for the **Mass List Edit** procedure, except the **Threshold** parameters, which are set to zero. This has the effect that the peak finder, which was used for a Mass List Find, is as sensitive as possible in order to detect additional peak with Mass List Edit manually.

**Figure 2-68  Mass List Edit – define special values**

If the checkbox is activated (see Figure 2-68) different parameters can be selected. The Edit field Maximal Number of Peaks is deactivated because only one peak is detected at a time.

**Processing Smoothing**

The settings for Smoothing process can be adjusted in the section Smoothing. flexAnalysis supports three different smoothing algorithms: Savitzky-Golay, Gauss, and Chemical Noise. Which one is used depends on the application.

For all filters the smoothing **Width** can be chosen. The **Width** range is from 0 to 100, the user is asked to find out the best fitting value.
The **Cycles** determines the number of smoothing processes on one analysis. One cycle is recommended. This parameter is not applicable together with the algorithm Chemical Noise.

The idea of the Savitzky-Golay algorithm is to calculate polynomials in the neighborhood of each data point to get a smoothing of the data. This can be formulated as

$$\tilde{y}_i = \sum_{k=-M}^{M} c_k y_{i+k}$$

with coefficients $c_k$. The parameter $M$ in the formula is calculated from the given $m/z$ smoothing width. The number of smoothing cycles can also be chosen which gives the option to apply this smoothing filter multiple times.

**Figure 2-69**  Method parameters – Smoothing

**Processing Baseline Subtraction**

The settings for Baseline Subtraction processes can be adjusted in the section **Baseline Subtraction** (see section 2.4.4.2). Two different algorithms are offered: **Median** and **TopHat**. A deprecated algorithm is ConvexHullV3.
Figure 2-70 Method parameters – Baseline Subtraction

The algorithm Median (recommended for FAST segment spectra and polymers) is determined through the parameters Flatness and MedianLevel. A spectrum that will be baseline subtracted is divided into a number of segments. The minimal number of segments is 1, i.e. Flatness equals zero. The maximal number of segments is 100, which corresponds to a Flatness of 1. A strong baseline drift is associated with high Flatness values.

The parameter Flatness influences the number of parabolas used to explain the baseline and the flatness of the resulting spectrum, which is obtained by subtracting the baseline from the spectrum. The larger the flatness value the finer the baseline will approach the spectrum.

The following values are recommended for Flatness:

0.0 — for totally flat spectra without baseline drift,

0.1 — for protein spectra, and

0.8 — for digest spectra, recorded in reflector mode.

The Median Level allows shifting the baseline relative to the data. By definition, if we have 100 data points, the median (a common statistical size) is the value of data point 50 after the data points are sorted by their y values. If we have a very dense spectrum, then the sorted data point #50 can already be something that is in the data level, well above the baseline. In these cases, we can tell the software not to use the median as defined (data point #50), but, say, use the value of data point #30, which is then supposed to be part of the baseline, and not part of the data.
The algorithm TopHat constructs the baseline by means of morphology operators. The baseline of the spectrum is obtained in two steps: first each data point is replaced by the minimum value of the spectrum within n data points, which gives the so called “erosion”. Then within the same number of data points, each value is replaced by the local maximum of the minimal values giving the “opening” of the spectrum, which is the baseline. The number of data points over which the minimum and maximum value is searched for is a function of the mass and is increasing in a way to get a good removal of the baseline but to minimize the distortion of the peaks.

TopHat should not be used for protein spectra.

**2.4.7.5.2 FAST (only for FAST Segment Spectra)**

![Processing Parameter Editor (FAST)](image)

**Figure 2-71 Processing Parameter Editor (FAST)**

The FAST tab (see Figure 2-71) is only available for a FAST Segment analysis. This tab allows deciding if smoothing and baseline subtraction are performed before the FAST segments are pasted. If both functions are selected first smoothing is performed. The algorithms used for these processing procedures are taken from the Process tab.

**Note** Please use Median as baseline subtraction algorithm if you want flexAnalysis to perform a baseline subtraction before pasting.
2.4.7.5.3 Calibration

The parameters selected and adjusted in the **Calibration** tab determine the results of the internal calibration. The settings correspond to the settings in the **Internal Calibration** dialog (see section 2.4.5.1). The **Calibration** tab in the **Parameters Editor** is used in context with methods and automation, whereas the **Internal Calibration** dialog is used for manual calibration. Nevertheless both dialogs contain the same information. Changes done in one of them are transferred to the other!

Select first the calibration strategy you want to use.

The adjustable parameters on this tab have been explained in detail in section 2.4.5.1. The pull down menu Mass control list contains predefined calibration lists that can be used for recalibration. The lists can be modified with the **Edit** button. The **Mass Control List Editor** opens and shows the selected list (see Figure 2-73).
**Figure 2-73  Mass Control List Editor**

Masses can be marked as calibrants by activating the corresponding checkbox.

**Note:**

- Only lists with at least one mass marked as calibrant appear in the drop down menu Mass control list.

- The Tolerance values are used for Background identification as well as for calibrant assignment.

- When a mass control list was opened from the **Calibration** tab or dialog only the **Calibrant** column is shown and masses can only be marked as **Calibrant**. When you want to mark them (additionally) as background masses you have to open the **Mass Control List Editor** via the **Mass List** menu!

Apply [Import Peak List...](#) to import an entire peak list into the editor. This list may be saved and also used as calibration and/or background list.

A pre-installed, i.e. write protected mass control list can be saved with another file name. The new file is added to the MassControlLists directory and can now be used from all programs that work with MCLs.
The same mass control lists that are available in flexAnalysis are also available in flexControl (Calibration tab) and AutoXecute (Evaluation tab). So, if a list is changed in one of these programs, this change is also available in the other programs.

For information about the other features of the Recalibration Masses tab please refer to section 2.4.5.

### 2.4.7.5.4 Mass List Layout

**Figure 2-74  Processing Parameter Editor (Mass List Layouts)**

flexAnalysis offers 10 parameters that may be displayed in the Mass List Window. The choice can be done via the Layout tab. The layout is part of the flexAnalysis method. So if you want to change it permanently for use with other spectra save the method (!) afterwards. If only the just opened analysis is saved, the layout setting refers only to this analysis (because it is saved in the file Analysis.FAmethod that only belongs to this analysis).

- The pull down list can be opened with the button **New (Insert)**. 

---

*Bruker Daltonik GmbH* 

*2 Graphical User Interface (GUI)* 

*Page 99 of 176*
The button **Delete** is used to remove a peak property from the Mass List Window.

The button **Move Up** or the related short cut (ALT+Up Arrow) and the button **Move Down** or the related short cut (ALT+Down Arrow) is used to change the arrangement of the displayed peak properties.

**Note** Some peak finding results are specific to a certain peak finding algorithm, e.g. the Quality Factor. If the parameter column is shown and the peak list has been created for example with SNAP, the Quality Factor column remains empty.

### 2.4.7.5.5 SmartFormula List Layout

**Figure 2-75  Processing Parameter Editor (SmartFormula Layouts)**

flexAnalysis offers 19 parameters that may be displayed in the SmartFormula List Window. The choice can be done via the **SmartFormula List Layout** tab. The layout is part of the flexAnalysis method. So if you want to change it permanently for use with other spectra save the method (!) afterwards. If only the just opened analysis is saved, the layout setting refers only to this analysis (because it is saved in the file Analysis.FAmethod that only belongs to this analysis).

- The pull down list can be opened with the button **New (Insert)**.

- The button **Delete** is used to remove a peak property from the Molecular Formula Result List Window.
The button Move Up or the related short cut (Alt + Up Arrow) and the button Move Down or the related short cut (ALT+ Down Arrow) is used to change the arrangement of the displayed peak properties.

For details on the SmartFormula parameters, please refer to section 2.4.11.4.

2.4.7.5.6 Display

![Parameters Only](image)

**Figure 2-76 Processing Parameter Editor (Display)**

In this dialog the number of displayed digits for masses in the display and the Mass List Window (peak list) can be changed.

**Checkbox Replace Original**

When this box is activated (default setting) the new result spectrum (after baseline subtraction or smoothing) replaces the previous original spectrum in the Analysis List Window. The spectrum color remains the same. No additional spectrum is displayed.

If this box is not selected an additional spectrum is attached to the tree view with different color due to the color hierarchy.

2.4.7.6 Edit Processing Parameters

The Edit Processing Parameters command, the corresponding icon of the toolbar, and the short cut (SHIFT+F2) are used to open the `flexAnalysis Processing Parameter Editor` (see section 2.4.7.5.1).
2.4.7.7 Edit Script

The **Edit Script** command, the corresponding icon of the toolbar, and the short cut (CTRL+F2) are used to open the flexAnalysis **Sax-Basic Script Editor**. This is an interactive design environment to develop, test, and execute Sax-Basic scripts. Sax Basic is Visual Basic for Applications™ compatible. Scripts are used to process analyses automatically. In the flexAnalysis environment, scripts are part of an analysis or a method.

The contents of a script are normally processing instructions for a particular analysis the method belongs to.

**Note** It is important to remember that to perform processing on any spectra, the relevant commands must be available in the method script. For example, this means that it is not sufficient to just select a smoothing algorithm, the method script must contain the command "perform smoothing". If you are not sure how to implement special processing in a method script, please contact Bruker at maldi.sw.support@bdal.de to discuss your requirements.

General information about Sax Basic Scripting can be found in the corresponding Help file. For detailed information about Sax Basic Scripting please refer to the *flexAnalysis Scripting Manual* (#263783).

On launching the **Script Editor** flexAnalysis loads the script of the processing method currently assigned to the selected analysis. The **Script Editor**'s title bar shows the name of the open processing method and the analysis name in parentheses. In case of a modified but not yet saved method, the '(modified)' indicator is appended to the method name.

![Example of a Basic script](image)

**Figure 2-77** Example of a Basic script
2.4.7.8 Select Default

Every spectrum that is opened in flexAnalysis needs to have a flexAnalysis method. This method is automatically assigned on different ways (depending on save processes in flexControl, AutoXecute, or flexAnalysis that occur before), so the user is not requested to do anything.

During the manual saving in flexControl it is possible (and sometimes recommended) to indicate a flexAnalysis method that is used for post processing later on. If no method has been indicated each spectrum automatically gets a default method assigned during the load process. This default method is determined in the dialog Default Method Selection. For five possible spectra types, suitable methods are available (see Figure 2-78).

![Default Method Selection](image)

**Figure 2-78 Default methods that are assigned to spectra that have no method**

The methods **ParametersOnly** contain a set of suitable parameters and an empty script. For this reason (empty script → no commands) no processing and especially no saving takes place if a spectrum gets “ParametersOnly” assigned.

The pre-installed default settings are ParametersOnly for MS spectra and SNAP_full_process for LIFT spectra. Certainly this can be changed, especially if the user does not want a script running for every spectrum that is newly loaded.
**Note**  When spectra are acquired with an AutoXecute run it is recommended to assign flexAnalysis methods during the run, so that they are automatically processed (peak find, recalibration, smoothing baseline subtraction, and so on). Otherwise the spectra would only be saved to the hard drive.

### 2.4.8 FAST Menu

![FAST Menu](image)

**Figure 2-79  Contents of the FAST menu**

The **FAST** menu offers FAST specific operations and is only available if a FAST segment analysis or FAST analysis is unambiguously selected. For all other spectra types the menu entries are not selectable. To display FAST segments with their correct mass values flexAnalysis is capable to recognize the analysis type during loading.

**Table 2-8  Features of the FAST menu**

<table>
<thead>
<tr>
<th>Mass List menu commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste Segment Spectra</td>
<td>Pastes all segments to one spectrum.</td>
</tr>
<tr>
<td>Change Parameters</td>
<td>To change parent and segment parameters.</td>
</tr>
<tr>
<td>Delete Segment Spectra</td>
<td>Deletes segment spectra from hard disk.</td>
</tr>
</tbody>
</table>

#### 2.4.8.1 Paste Segment Spectra

The **Paste Segment Spectra** command is used to paste FAST segment spectra to one linearized FAST spectrum.

Raw data (fids) are used in the paste process. The following rule is applied for pasting:
First flexAnalysis uses the penultimate segment \((n-1)\) until mass \(m_{\text{max}}\), and then follows the last segment \((n)\) without overlapping both segments.
Figure 2-80  Example of a segment spectrum before and after pasting

The paste procedure results in a new analysis that is also shown in the tree view. This analysis contains all spectra, which arise from multiple use of the Paste command referring on the same FAST segment analysis.

Figure 2-81  FAST segments and corresponding pasted FAST spectrum
Results are not automatically saved after manual pasting. On saving an analysis, which contains the result of a paste procedure, a result spectrum of this analysis is saved in a directory: `\samplename\<parentmass>.FAST.FAST`.

![Figure 2-82](image.png)

**Figure 2-82** Result spectrum folder of a paste procedure

**Note** If there is already a spectrum in `\samplename\<parentmass>.FAST.FAST` it will be overwritten, because on the hard drive at any time only one result spectrum is allowed.

### 2.4.8.2 Change Parameters

The **Change Parameters** command is used to change the parent mass, the FAST segment parameters per segment, for example the segment range, and to recalibrate FAST segment spectra afterwards. The operator can apply a new calibration file for recalibration in case of Segment Spectra acquired with flexControl versions < 2.0.

The **Change Parameters** command opens a dialog that lists the segment boundaries in `\m/z\`. Applying the radio button `FASTLow / FASTHigh` the same segment boundaries are shown in the relation `FASTLow / FASTHigh`. 
Figure 2-83   Changing segment ranges using \( m/z \) values

2.4.8.3   Delete Segment Spectra

The **Delete Segment Spectra** command is active if FAST segments are successfully pasted and the pasted spectrum has been saved. The command closes all FAST segments and deletes them from the hard drive. This feature corresponds to erasing a directory. Applying this command opens a message (see Figure 2-84). Afterwards only the pasted FAST spectrum remains on disk!

Figure 2-84   Message before erasing the folder
2.4.9 View Menu

![View Menu Screenshot](image)

Figure 2-85 Contents of the View menu

2.4.9.1 Viewing Mass Spectra

The perspective of the loaded mass spectra can be shown using the **Overlaid**, **Stacked** and **List** options.

In **Overlaid** mode all mass spectra share the same x-y-axes.

In **Stacked** mode all mass spectra share the same x-y-axes, but have different z-axes.

In **List** mode each mass spectra is displayed in its own list window. In the shortcut menu appears the new option **List Windows** to select, how many spectra will be shown at once.
Table 2-9  Features of the View menu

<table>
<thead>
<tr>
<th>Feature button</th>
<th>View menu commands</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Auto-Scaling</td>
<td>ALT+F9</td>
<td>Toggles the abscissa and, if possible, the ordinate of the active data window between auto-scaling and manual scaling.</td>
</tr>
<tr>
<td></td>
<td>Scale to entire Spectrum</td>
<td>CTRL+F9</td>
<td>All currently displayed spectra are completely shown; however auto scaling is not switched on.</td>
</tr>
<tr>
<td></td>
<td>Horizontal Auto-Scaling</td>
<td></td>
<td>Returns from manual horizontal scaling to auto scaling.</td>
</tr>
<tr>
<td></td>
<td>Vertical Auto-Scaling</td>
<td></td>
<td>Returns from manual vertical scaling to auto scaling.</td>
</tr>
<tr>
<td></td>
<td>Set Display Range</td>
<td></td>
<td>Sets the data display range for the active data window.</td>
</tr>
<tr>
<td></td>
<td>Zoom</td>
<td>F9</td>
<td>Zooms the selected data range.</td>
</tr>
<tr>
<td></td>
<td>Zoom X</td>
<td>SHIFT+F9</td>
<td>Zooms only in x direction</td>
</tr>
<tr>
<td></td>
<td>Undo Zooming</td>
<td>ALT+LEFT ARROW</td>
<td>Undoes the last zooming step.</td>
</tr>
<tr>
<td></td>
<td>Redo Zooming</td>
<td>ALT +RIGHT ARROW</td>
<td>Redoes the previous unzoom step.</td>
</tr>
<tr>
<td></td>
<td>Toolbars</td>
<td></td>
<td>Shows, hides, or customizes toolbars.</td>
</tr>
<tr>
<td></td>
<td>Status Bar</td>
<td></td>
<td>Shows or hides the Status Bar.</td>
</tr>
</tbody>
</table>

2.4.9.2  Auto-Scaling

The **Auto-Scaling** command, the corresponding tool button and the short cut (Alt + F9) are used to toggle abscissa and ordinate in the Mass Spectrum window between auto-scaling and manual scaling. On selecting this command, the auto-scaling mode takes effect or not. Auto-scaling means that the display range of both axes is automatically
adjusted to display the maximum measured values. When this mode is active, the corresponding tool button in the toolbar is highlighted.

**Note** When using this command in the Mass Spectrum window, the operator cannot individually set the auto-scaling status for the y- or x-axis.

Any changes of the y- or x-axis display range will deactivate auto-scaling of the corresponding axis/axes.

Auto-scaling can be activated and de-activated with double-click in the display or beneath and next to the x- and y-axis. Additionally the buttons and can be used.

2.4.9.3 **Scale to Entire Spectrum**

The Scale to Entire Spectrum command and the short cut (CTRL+F9) are used to return from a zoomed section of a spectrum to the total spectrum. This command has the same effect as Auto-Scaling, however the auto-scale mode is not switched on after this command is executed.

2.4.9.4 **Horizontal and Vertical Auto Scaling**

The Horizontal/Vertical Auto-Scaling command and the corresponding feature button are used to display the entire (mass/intensity) spectrum in the Mass Spectrum Window.

2.4.9.5 **Set Display Range**

The Set Display Range command is used to specify ranges for the x- and y-axis. The Set Display Range dialog box opens, which allows setting the mass range and the intensity scale when the checkboxes Auto-Scaling are not selected.

![Set Display Range dialog box](image)

**Figure 2-86** Set Display Range dialog box
2.4.9.6  

**Zoom**

The **Zoom** command, the corresponding icon of the toolbar, and the short cut (F9) are used to zoom a section of the display range in the display. The stack facility is also available here, so the operator can toggle between the **Undo Zooming** and **Redo Zooming** commands.

The Zoom In function is active after the corresponding tool button is applied. Consequently the mouse pointer converts automatically into the Zoom In pointer inside the spectrum window.

The Zoom In function also becomes active when the mouse pointer is inside the Mass Spectrum Window and the SHIFT key is pressed.

2.4.9.7  

**Zoom X**

The **Zoom X** command, the corresponding icon of the toolbar and the short cut (Shift + F9) are used to zoom spectra or peaks in x-direction. The ordinate value remains unchanged.

2.4.9.8  

**Undo Zooming**

The **Undo Zooming** command, the corresponding icon of the toolbar, the short cut (ALT+ LEFT ARROW), and a simple mouse click into the Mass Spectrum window (when the Zoom mode is active) are used to reverse the last zooming step that was performed. flexAnalysis is able to put the last twenty zooming steps of the current session into a particular stack.

This allows the operator to go back to previous zoom steps by continuously selecting **Undo Zooming** until the desired display is reached. When the last step from the stack is reached, flexAnalysis deactivates this function.

2.4.9.9  

**Redo Zooming**

The **Redo Zooming** command, the corresponding icon of the toolbar, or the short cut (ALT+RIGHT ARROW) are the counterpart of the **Undo Zooming** function and are used to retrieve a previous step reversed with the **Undo Zooming** command. On selecting
**Redo Zooming**, the display range switches to the zooming step that was performed previously.

Also here flexAnalysis stacks up to twenty last zooming steps performed during the current session.

### 2.4.9.10 Toolbars

The **Toolbars** command opens the **Toolbars** dialog box (see Figure 2-87). This feature is used to show, hide, or customize toolbars. This is done by selecting or clearing the corresponding check box, which shows or hides the respective part of the toolbar on the GUI.

![Toolbars dialog box](image)

**Figure 2-87 The Toolbars dialog box**

The list box **Toolbars** shows all the toolbars currently defined (defaults as well as custom toolbars). Each toolbar has a check box in front of it indicating its current display status.

The button **New** allows users to create a custom toolbar.

![New toolbar dialog](image)

**Figure 2-88 New toolbar dialog**
2.4.9.11 Status Bar

The **Status Bar** command is used to show or hide the status bar at the bottom of the GUI. When the status bar is visible, it is indicated by a highlighted check mark in front of this command.

2.4.10 Report Menu

![Report Menu](image)

**Figure 2-89 Contents of the Report menu**

The **Report** menu is composed of commands to report processing results.

<table>
<thead>
<tr>
<th>Feature button</th>
<th>Method menu commands</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Preview" /></td>
<td>Preview</td>
<td></td>
<td>Preview the report.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Print</td>
<td>CTRL+P</td>
<td>Print the report.</td>
</tr>
<tr>
<td><img src="image" alt="Save As PDF" /></td>
<td>Save As PDF</td>
<td></td>
<td>Save the report as a PDF file.</td>
</tr>
<tr>
<td><img src="image" alt="Save As HTML" /></td>
<td>Save As HTML</td>
<td></td>
<td>Save the report as an HTML file.</td>
</tr>
<tr>
<td><img src="image" alt="Report Designer" /></td>
<td>Report Designer</td>
<td></td>
<td>Launches the Report Designer.</td>
</tr>
</tbody>
</table>

2.4.10.1 Print Preview

The **Print Preview** command and the corresponding feature button of the toolbar open the **Report Preview** dialog (see Figure 2-90). The printer and special report layouts
can be chosen here. The button **Preview** at the bottom of the dialog opens the actual preview and displays the selected spectrum, as it would appear in the printout.

Layouts can be created, designed, and modified with the Report Designer. The button **Report Designer** starts this application. It is described in section 2.4.10.1 and in the *Report Designer User Manual* on the installation DVD.

![Preview Report dialog](image)

**Figure 2-90**  Preview Report dialog

If user-defined report layouts are created on the basis of pre-installed layouts, it is recommended to store the original layout before modifications are made and to save the modified file with a new name. Additionally be aware to use the default file structure to save report files: `D:\Methods\Report Layouts\flexAnalysis`. 
If flexAnalysis is installed on a standalone system the path probably depends on the adjusted Regional Setting of the operating system. Otherwise the saved files cannot be located.

2.4.10.2 Print

The Print Command, the corresponding toolbar button and the short cut (CTRL+P) open the Print dialog (see Figure 2-91). A printout can be done from here by clicking OK.

![Print Report dialog](image)

Figure 2-91 Print Report dialog
2.4.10.3 Save As PDF

With flexAnalysis 3.4 it is possible to save printouts directly as PDF files without the need to first install a PDF printer driver, and use of a special flexAnalysis method. After the menu entry has been selected the Save Report As dialog opens (see Figure 2-92).

![Save Report As dialog](image)

**Figure 2-92  Save Report As dialog**

Click the browse button next to the PDF File Name field to select a location on the hard drive where the PDF will be saved and append the file name. Printer properties and report layout format can be defined in the Printer and Report Layout group boxes.

It is possible to save PDF files for several spectra with the preinstalled methods ReportToPDF.* (for MS and LIFT spectra), and the Batch Process (see section 2.4.4.4). The desired layout must be specified in the method script. Please contact maldi.sw.support@bdal.de in case of questions.
2.4.10.4 Save As HTML

To export results in html format, select Report > Save As HTML, click the browse button next to the HTML File field to select a location on the hard drive where the html file will be saved and append the file name. Report layout format can be defined in the Report Layout group box.

![Save Report As dialog box](image)

**Figure 2-93** Saving a report as an html document

2.4.10.5 Report Designer

The ReportDesigner command, and the corresponding toolbar button are used to start the Bruker Daltonics ReportDesigner, which allows creating user-defined report layouts. Existing layouts can be modified and new ones can be set up.
To create a new report layout, it is recommended not to modify the original layout but to save the modified layout to a new file name. Otherwise, it is possible that your modified layout may be overwritten by a later upgrade of the software.

Use the File > Open command in the ReportDesigner to open and, if needed, edit an existing report layout or use the File > New command to set up a new layout.

**Note** For detailed information to work with the ReportDesigner, refer to the manuals on the installation DVD.

![ReportDesigner with loaded report layout](Image)

**Figure 2-94** ReportDesigner with loaded report layout

▶▶ To create a new layout by modifying an existing layout

1. Click the ReportDesigner toolbar button or select Report > ReportDesigner.

2. Select File > Open.

3. In the Open dialog navigate to the layout file (*.layout) that will be used as a template to create a new layout and click Open.

   The selected layout is loaded.
4. Modify the layout as desired.

5. Select File > Save As and save the modified layout to a new file name.

6. To close ReportDesigner, select File > Exit.

►► To create a new layout from scratch

1. Click the ReportDesigner toolbar button or select Report > ReportDesigner.

2. Select File > New.

3. Set up the layout as desired.

4. Select File > Save As and save the modified layout to a new file name.

5. To close ReportDesigner, select File > Exit.

Report Layout files are installed in a folder named Report Layouts, which is located in the methods directory (normally D:\Methods\).

2.4.11 Tools Menu

![Tools Menu](image)

Figure 2-95 Contents of the Tools menu
2.4.11.1 BioTools

BioTools is a Bruker program for peak annotation of amino acids, whose spectra have already been processed, for example, with flexAnalysis. BioTools uses these spectra and peak lists for de novo sequencing on Internet searches.

The BioTools command is active if BioTools is installed (in a compatible version) on the same computer and if an analysis is loaded and marked in flexAnalysis. The command is used to save the currently active spectrum, open the BioTools program, and transfer the spectrum to BioTools.

2.4.11.2 PolyTools

PolyTools is a program from Bruker for determination of monomers, end groups and cations. Spectra must be already processed, for example, with flexAnalysis since PolyTools needs these spectra and peak lists. If isotopes are resolved in the measured
spectrum, lines belonging to the isotope distribution are identified and can be reduced to amino isotopic series.

For every isotope series or the reduced monoisotopic series, the average molecular weight, polydispersity, and degree of polymerization are determined. It is also possible to enter repeat unit, end groups and cation manually, either in addition to or replacing the values found automatically. New stick spectra calculated from all these data are displayed together with the experimental spectrum for comparison. For more information, refer to the PolyTools User Manual (#205659).

The PolyTools command is active if PolyTools is installed on the same computer. After a spectrum is loaded in flexAnalysis this command is used to open the PolyTools program and to transfer the current spectrum.

2.4.11.3 ProteinScape

ProteinScape is a tool for storing, organizing and analyzing data generated during the proteomics workflow.

The following basic tasks are supported:

- Data archiving and organization.
- Data viewing and reporting.
- In-depth data handling.
- Data analysis

ProteinScape is designed as a client-server platform with a simple web browser-based user interface. It operates with industry-standard relational database systems like Microsoft SQL Server.

When the ProteinScape psClient is installed on a computer, communication with ProteinScape is possible. Every time flexControl or flexAnalysis is started, the user must log in to ProteinScape, even if ProteinScape will not be used in the session. To avoid this, the ProteinScape login can be deactivated.

**Note** Because the ProteinScape connection is essential for WARP-LC, it is not possible to perform WARP-LC runs if the ProteinScape login is deactivated.

To temporarily deactivate ProteinScape login, select **Start > Programs > Bruker Daltonics > Utilities > flexConfigurator** and click **OK**. The **flex Configuration** dialog
(see Figure 2-96) will open. Select Misc in the flexControl group box and select No in the drop-down list to the right of ProteinScape Login to deactivate the ProteinScapeLogin.

![Figure 2-96 ProteinScape Login setting in the flex Configuration dialog](image)

The ProteinScape command in the flexAnalysisTools menu is active if the ProteinScape psClient is installed. This client must be downloaded from the ProteinScape server. The ProteinScape command is used to send spectra to the ProteinScape database. For more detailed information refer to the ProteinScape User Manual.

The communication of flexAnalysis with ProteinScape:

- flexAnalysis 3.4 without psClient: No communication with ProteinScape. The command Tools > ProteinScape is unavailable.

- flexAnalysis 3.4 and psClient 3.0: The communication with ProteinScape 3.0 is enabled. The dialog of psClient is available.

After the command has been executed, a dialog appears (see Figure 2-97).
Figure 2-97  Send to ProteinScape dialog

Clicking the button in the left upper corner opens the Export to ProteinScape dialog (see Figure 2-98), which is described in the ProteinScape User Manual.
The SmartFormula Manually command is used to calculate possible molecular formulas of a measured $m/z$ value taken from a highly resolved mass spectrum. Patterns of a calculated formulas can be preserved by saving them with the original spectrum as an XML file.

The basic result elements of a SmartFormula operation may be displayed in HTML format and printed out.
The calculation of elemental compositions of molecular (and fragment) ions need exact mass determinations from a highly resolved mass spectrum. The aim is to determine all theoretically possible elemental compositions of a mass, within a specified error tolerance.

The higher the measured mass, the more elemental compositions are possible. For example, up to a mass of 1000 Da approximately 66,000 compositions are theoretically possible solely consisting of C, H, N and O. For masses up to 2000 Da this value increases up to 520,000. Additional elements that may be found in the compositions will extremely increase the number of compositions.

Because of this large number of possible combinations it is very time-consuming to trace all of them and compare the resulting mass with the measured mass. Therefore, the number of solutions needs to be restricted. One way is to limit the allowed ranges of the occurring atoms. The problem here is to set the limits in such a way that the correct combination will not be excluded. A better way is to use a more intelligent algorithm to confine the number of combinations to be examined.

flexAnalysis uses an algorithm that is based on the fact that the integer part and the fractional part of the molecular mass are linearly independent for organic molecules up to a molecular mass of about 1000. This is used for combining C, H, N and O. The other elements, which usually occur in smaller numbers, are dealt with using the straightforward try-and-error method.

The calculations used to generate molecular formulas are based on defined isotope masses and abundances and atomic valences (see section A.3).

Selecting the SmartFormula Manually command opens the SmartFormula Manually dialog (see Figure 2-99), which enables direct entry of an m/z value and definition of how the calculation is carried out.
For $m < 2000$ the elements C, H, N, and O are considered implicitly.

<table>
<thead>
<tr>
<th>#</th>
<th>Mol. Formula</th>
<th>m/z</th>
<th>err ppm</th>
<th>mSigma</th>
<th>rclb</th>
<th>N rul</th>
</tr>
</thead>
<tbody>
<tr>
<td>33</td>
<td>C$<em>{113}$H$</em>{158}$N$<em>{29}$O$</em>{34}$</td>
<td>2465.152950</td>
<td>5.984</td>
<td>671.852</td>
<td>49.5</td>
<td>c</td>
</tr>
<tr>
<td>34</td>
<td>C$<em>{112}$H$</em>{150}$N$<em>{27}$O$</em>{37}$</td>
<td>2465.068045</td>
<td>40.060</td>
<td>671.943</td>
<td>51.5</td>
<td>c</td>
</tr>
<tr>
<td>35</td>
<td>C$<em>{112}$H$</em>{162}$N$<em>{25}$O$</em>{38}$</td>
<td>2465.150712</td>
<td>6.526</td>
<td>671.944</td>
<td>44.4</td>
<td>c</td>
</tr>
<tr>
<td>36</td>
<td>C$<em>{113}$H$</em>{161}$N$<em>{30}$O$</em>{33}$</td>
<td>2466.183684</td>
<td>41.250</td>
<td>672.127</td>
<td>48.5</td>
<td>c</td>
</tr>
<tr>
<td>37</td>
<td>C$<em>{113}$H$</em>{155}$N$<em>{30}$O$</em>{33}$</td>
<td>2464.168034</td>
<td>405.152</td>
<td>672.157</td>
<td>49.5</td>
<td>c</td>
</tr>
<tr>
<td>38</td>
<td>C$<em>{112}$H$</em>{165}$N$<em>{26}$O$</em>{37}$</td>
<td>2466.182347</td>
<td>41.195</td>
<td>672.211</td>
<td>43.5</td>
<td>c</td>
</tr>
<tr>
<td>39</td>
<td>C$<em>{112}$H$</em>{153}$N$<em>{28}$O$</em>{36}$</td>
<td>2466.099680</td>
<td>378.424</td>
<td>672.213</td>
<td>50.5</td>
<td>c</td>
</tr>
<tr>
<td>40</td>
<td>C$<em>{112}$H$</em>{163}$N$<em>{26}$O$</em>{37}$</td>
<td>2464.166997</td>
<td>405.594</td>
<td>672.241</td>
<td>44.4</td>
<td>c</td>
</tr>
<tr>
<td>41</td>
<td>C$<em>{112}$H$</em>{151}$N$<em>{28}$O$</em>{36}$</td>
<td>2464.084030</td>
<td>439.228</td>
<td>672.243</td>
<td>51.5</td>
<td>c</td>
</tr>
<tr>
<td>42</td>
<td>C$<em>{112}$H$</em>{166}$N$<em>{27}$O$</em>{36}$</td>
<td>2465.198331</td>
<td>12.790</td>
<td>672.511</td>
<td>43.5</td>
<td>c</td>
</tr>
<tr>
<td>43</td>
<td>C$<em>{112}$H$</em>{154}$N$<em>{29}$O$</em>{35}$</td>
<td>2465.115664</td>
<td>20.744</td>
<td>672.515</td>
<td>50.5</td>
<td>c</td>
</tr>
<tr>
<td>44</td>
<td>C$<em>{111}$H$</em>{158}$N$<em>{25}$O$</em>{39}$</td>
<td>2465.114327</td>
<td>21.286</td>
<td>672.604</td>
<td>45.5</td>
<td>c</td>
</tr>
<tr>
<td>45</td>
<td>C$<em>{112}$H$</em>{169}$N$<em>{28}$O$</em>{35}$</td>
<td>2466.229966</td>
<td>431.275</td>
<td>672.783</td>
<td>42.5</td>
<td>c</td>
</tr>
<tr>
<td>46</td>
<td>C$<em>{112}$H$</em>{157}$N$<em>{30}$O$</em>{34}$</td>
<td>2465.147299</td>
<td>397.741</td>
<td>672.790</td>
<td>49.5</td>
<td>c</td>
</tr>
<tr>
<td>47</td>
<td>C$<em>{112}$H$</em>{167}$N$<em>{28}$O$</em>{35}$</td>
<td>2464.214316</td>
<td>386.377</td>
<td>672.813</td>
<td>43.5</td>
<td>c</td>
</tr>
<tr>
<td>48</td>
<td>C$<em>{112}$H$</em>{155}$N$<em>{30}$O$</em>{34}$</td>
<td>2464.131649</td>
<td>419.912</td>
<td>672.819</td>
<td>50.5</td>
<td>c</td>
</tr>
<tr>
<td>49</td>
<td>C$<em>{111}$H$</em>{161}$N$<em>{26}$O$</em>{38}$</td>
<td>2465.145961</td>
<td>397.199</td>
<td>672.872</td>
<td>44.5</td>
<td>c</td>
</tr>
<tr>
<td>50</td>
<td>C$<em>{111}$H$</em>{159}$N$<em>{26}$O$</em>{38}$</td>
<td>2464.130311</td>
<td>420.454</td>
<td>672.901</td>
<td>45.5</td>
<td>c</td>
</tr>
</tbody>
</table>

Figure 2-99  
Generate Molecular Formula dialog

Enter all the elements with their allowed minimum (Min) and maximum (Max) atom numbers on which the chemical formula calculation is based. Formula calculation will start at the formula entered in Min and stop at the formula entered in Max.

Note  
For $m < 2000$ the elements C, H, N, and O are considered implicitly.

Determining minimum and maximum formulas

- Generally a CHNO distribution will be calculated. To exclude one of these atoms from the calculation, set it to ‘0’ (zero). For example, to exclude nitrogen from a
calculation, enter 'N0'.

- Sorting of elements is not required.

- Brackets can be used to enter fixed atom ratios that should not be resolved. For example, when entering '[N3P3O6]CHF' for Min and '[N3P3O6]C100H21F80' for Max, then calculation will use exactly 3 N, 3 P and 6 O but 1 to 100 C, 1 to 21 H and 1 to 80 F.

- Chemical notation can be used. For example, '(CH3)6' will be resolved to C6H18.

**Unavailable field (Summary of Min/ Max rows above)**

Lists the constraints to generate molecular formulas as specified in Min and Max, i.e. the elements and minimum/maximum atoms numbers allowed. Within these bounds molecular formula calculation will occur.

**Measured m/z**

Enter the measured m/z value for which possible molecular formulas should be calculated. Enter this value either by typing it in or by selecting the value in the Mass List window.

**Tolerance [ppm]**

Enter the error tolerance for the mass range to be analyzed in [ppm]. This is a range within that flexAnalysis calculates the m/z value of the molecular formulas. The default value depends on the kind of the selected analysis. For FTMS analyses, the default value is 2 ppm, for ESI-TOF analyses 4 ppm and for all the other analyses 50 ppm.

**Charge**

For multiply charged ions, enter the assumed charge the ion of the Measured m/z carries. The default value is 1. Please take into account the sign of the charge. The mass of the electron is not negligible for high-precision instruments. Switching between +1 and −1 makes a difference of two electrons or 1.1 mDa, which represents 2 ppm for a molecule of 548 Da.
**Auto locate monoisotopic peak**

Select this option, if the monoisotopic peak corresponding to the measured m/z should be located automatically. The algorithm will search to the left and right of the selected measured m/z for appropriate sum formulas with their corresponding monoisotopic peaks.

To use this option select the largest peak of the pattern.

If the search was successful the found formula(s) for the corresponding monoisotopic peak(s) is entered into the results list.

In formulas containing a monoisotopic peak, which is different from the selected peak, the monoisotopic mass is slightly different by a few Da from the selected mass.

The mass error nevertheless is calculated for the selected peak and the exact theoretical mass of that peak based on the formula from Alan L. Rockwood et al. (J.Am.Soc. Mass Spectrom. 2004, 15, 12-21).

The default setting is cleared.

**Maximum number of formulas**

Enter the maximum number of molecular formulas to be calculated. The formulas with the smallest relative error based on the measured m/z will be picked out. The default value is 200.

**Check rings plus double bonds**

Select this option if possible molecular formulas should be checked whether the number of rings and double bonds present keeps within the bounds specified in Minimum and Maximum. This will exclude all possible formulas with deviating double bond equivalence numbers. Default is not selected.

The rings plus double bounds number is calculated from the number of atoms and their valence:

\[
R + db = \frac{2 + \sum n_{atom} \times (valence_{atom} - 2)}{2}
\]

The valence of C and Si is 4, for N and P a valence of 3 is assumed. For O and S it is 2, for H and the halogen atoms it is 1. For this limited set of atoms the equation simplifies to

\[
R + db = n_{(C)} - \frac{1}{2} n_{(H, D, F, Cl, Br, I)} + \frac{1}{2} n_{(N, P)} + 1
\]
All the other elements are also considered. Double bonds occurring with higher valence states like 4 or 6 for sulfur cannot be taken into account as these valence states are unknown.

**Minimum**

Enter the minimum number of rings plus double bonds to be contained in a molecular formula. This number may be negative for protonated clusters. The default value is 0.

**Maximum**

Enter the maximum number of rings plus double bonds to be contained in the molecular formula. The default value is 0.

**Filter H/C element ratio**

Check this option if possible molecular formulas should be filtered according to their ratio of the elements H and C. Only formulas that comply with the H/C ratios specified in **Minimum H/C ratio** and **Maximum H/C ratio** will be displayed.

**Electron configuration**

Select the kind of electron configuration to be applied:

- **Even**: Generates only molecular formulas having an even electron configuration.
- **Odd**: Generates only molecular formulas having an odd electron configuration.
- **Both** (default setting): Generates molecular formulas of both electron configurations.

The electron configuration is calculated under the assumption that molecular ions are present. The electron configuration is even, if \([n_{(atom)} \times \text{valence}_{(atom)} + z_{(ion)}]\) is even.
Estimate carbon number

Select this option if the minimum number of carbon atoms to be used in generating molecular formulas should be estimated by the program. The estimated number will be entered in Min after generating formulas has been started. If Min already contains a manually entered carbon number, the manually entered and the estimated number will be compared and the higher of both carbon numbers will be used. This option should be set if the monoisotopic peak could not be determined reliably, for instance, in compounds with a large number of carbon atoms or organometallic compounds.

For estimating the carbon number, the following assumptions are made: The selected m/z value corresponds to the m/z of the monoisotopic peak. The next peak that corresponds to the isotopomer with one ^12C less and containing exactly one ^13C, is 1.003355 +- distant from the selected m/z value. From the intensity ratio of both peaks, a carbon number is estimated and rounded down. This number is then used as the minimum carbon number in generating formulas.

Minimum C/H ratio

Enter the minimum C/H ratio to be applied. The default value is 0.

Maximum C/H ratio

Enter the maximum C/H ratio to be applied. The default value is 3.

Generate immediately

Select this option if SmartFormula generation should begin immediately when an m/z value is chosen in the Mass List window.

Generate

Generates molecular formulas for the mass range that is specified by the Measured m/z and Tolerance values that meet the current parameter settings and enters them along with corresponding data in the formula list.

If Show Pattern is already turned on, the pattern of the first formula in this list will be displayed below the original spectrum and entered in the Analysis List as a subentry of the original spectrum.
Save Results

Allows saving the molecular formula results list in an XML file. Opens the Save As dialog.

(List of generated molecular formulas)

Lists the molecular formulas that have been calculated for the specified Measured m/z value according to the current parameter settings.

For each formula the following set of data is calculated that includes for instance various error values, rankings and statistical values:

#: Consecutive number of the formula.

Mol.Formula: Molecular formula.

m/z: Measured m/z of the formula.

err [ppm]: Deviation between the measured mass and the theoretical mass of the selected peak.

mSigma: Sigma value which combines the standard deviation of the masses and intensities for all peaks. The value is given in [milliSigma].

rdb: number of rings and double bonds in the formula.

N rule: Indicates whether the nitrogen rule is fulfilled.

e-: Indicates whether the electron configuration is even or odd. The electron configuration is calculated under the assumption that we have molecular ions. The electron configuration is even, if \([n(\text{atom}) \times \text{valence(\text{atom})} + z(\text{ion})]\) is even.

The formulas are sorted with increasing err [ppm] by default. Clicking a column header sorts the list according to the column values.

Report

The Report button opens a HTML page containing the key information of the Generate Molecular Formulas operation (Figure 2-100).
Show Pattern

The **Show Pattern** button allows comparison of the pattern of the measured mass and the pattern of the selected formula (Figure 2-101) from the list of calculated masses (Figure 2-99).

Applying this button adds the pattern of the selected formula into the Mass spectrum window and the formula itself into the Analysis List window as a subentry of the original spectrum.
2.4.11.5  Macro Editor

flexAnalysis offers two different ways for an automatic processing: method scripts and macros. Method scripts and macros are treated differently and designed in different editors. The major difference is the range of application. Method scripts are intended to operate on the single analysis they are assigned to, while macros are independent of specific analyses.

The Macro Editor command is used to start the flexAnalysis Sax Basic Macro Editor (see Figure 2-102).
Figure 2-102  Sax Basic Macro Editor

- This editor is an interactive design environment for developing, testing, and executing Sax Basic macros. Sax Basic is Visual Basic for Applications™ compatible.

- flexAnalysis macros have a reference to Bruker flexAnalysis 3.4 Type Libraries, which makes all flexAnalysis scripting objects available.

- Please refer to the editor help from the Help menu in the flexAnalysis Macro Editor for a detailed description on how to open, to create, and to execute macros within the macro editor.

2.4.11.6  Customize

The Customize command is used to vary the contents of the menu bar. Additionally the user can remove or add parts of the toolbar. These features are available on the tabs Toolbars and Commands of the Customize dialog.
After opening, this dialog shows first the tab, which provides default palettes that contain feature buttons to be temporarily removed or docked on to the GUI by applying the corresponding check box (there is no access to the check box menu bar).

The button **New** opens the **New Toolbar** dialog in order to specify a name for the new empty palette that will appear at once on the Graphical User Interface after closing with the **OK** button.

The symbols of the **Commands** tab (Figure 2-105) may be used to add one or more functions to the new palette. For instance, the user wants to add the **Delete** symbol. To do so, switch to the **Commands** tab, open the category **Edit** and transport the **Delete** symbol with the drag and drop to the new palette.
In contrast to user-defined palettes, the defaults can only be removed from the GUI but not deleted out of the program. On choosing a user-defined palette the Reset button switches to Delete.

2.4.11.7 Options

The Options command and the corresponding icon of the toolbar are used to manipulate optional settings for flexAnalysis.

The related dialog (see Figure 2-106) consists of four tabs, Display, Labels, Export, and Calibration.
Figure 2-106  Option to specify the spectrum display

2.4.11.7.1  Display

The **Local Maximum** drawing optimization can be activated or deactivated in the **Drawing Optimization** section. This feature is activated by default and less noise is shown.

The stacked view can be configured in the **Stacked View** section. The parameter **Angle** arranges spectra in a specific angular position in the display whereas the parameter **Offset** specifies the distance between the displayed spectra. These parameters determine how spectra appear in the **Stacked View** of the display.

The parameter **Windows** of the section **List View** determines the number of windows displayed in the List view. The information displayed for the spectra can be defined in the **Title** drop-down box.

**None**: no spectrum information is shown
**Spectrum Info**: sample name, chip, sample position, spectrum type, in case parent mass and the processing state are shown

**Spectrum File Path**: the complete spectrum path is shown

**Comment1**: comment 1 is shown

**Comment2**: comment 2 is shown

**Comment3**: comment 3 is shown

### 2.4.11.7.2 Labels

![Option to specify the appearance of the peak annotation](image)

**Figure 2-107**  Option to specify the appearance of the peak annotation

The **Label** tab (see Figure 2-107) contains two groups of radio buttons to specify how peak labeling shall be performed.

**Density:**

- **Non-overlapping** — prevents overlapping of the labels with the spectrum curve. Labels are not shown, if they would overlap with the spectrum or neighboring labels.

- **Non-overlapping with ticks** — prevents overlapping of the labels and shows ticks on the top of a labeled peak.

- **Overlapping** — overlaps the peak labels. All labels of all peaks of the mass list are shown.

- **Ticks only** — shows only ticks on the top of detected peaks.
Orientation:

- **Horizontal** — displays the labels of the m/z values horizontally.
- **Vertical** — displays the labels of the m/z values vertically.

2.4.11.7.3 **Export**

![Export feature screenshot](image)

**Figure 2-108**  **Option to specify the numerical precision of the coordinates**

The Export feature allows the operator to adjust the numerical precision of the x (mass) and y (intensity) value. Choose these values as small as possible in order to save disk space and processing time. The values chosen here are the number of digits used for each data-point when exporting a mass spectrum. You can define with which resolution your graphics are exported by choosing to use the screen resolution or by adjusting the DPI value.
### 2.4.11.7.4 Calibration

![Options dialog for calibration settings](image)

**Figure 2-109** Option to specify the tolerance of the calibration strategy

Settings on this tab are relevant for internal recalibration (see section 2.4.5.1). The Near Neighbor tolerance applies to the Interactive calibration, whereas Default Calibrant is used for Statistical Peptide calibration.

Also the global use of High Precision Calibration (HPC) can be activated in this dialog. HPC is a fine correction of the calibration in the mass range between 700 and 4000 Da (see Appendix 1).

### 2.4.11.7.5 Application

![Options dialog for application settings](image)

**Figure 2-110** Options to specify how the application should work
Compatibility mode for deprecated processing parameters

There are processing parameters (e.g. ConvexHull), which were offered in older Compass for flex versions, but which are no longer under development and which are no longer supported. They are substituted by other ones. Therefore usually they are disabled in the GUI. Nevertheless there might be use cases where it still makes sense to use these deprecated parameters. You then have the possibility to choose whether the deprecated parameters should be enabled for this session or always. If you activate them for this session, the next time you start flexAnalysis, the parameters are disabled again.

In case an error message with the keyword deprecated appears you may either activate the compatibility mode (for most use cases not recommended!) or you may repair the method/spectrum parameter. How to do this is explained in section 2.2 of the document Quickstart_Deprecated_Parameters.pdf, available on your installation DVD.

Analysis List

With these settings you can change the behavior of the analysis list window (the tree view).

No Peaks: only the analysis and spectra lines are shown (conventional view)

Peaks with SmartFormula: the conventional view is expanded by the peaks, which have been created with the SmartFormula. This is the default setting.

Figure 2-111 Analysis List window, which shows SmartFormulas

All Peaks: all peaks, the peaks created with SmartFormula and the peaks of the peak list, are shown
2.4.11.7.6 SmartFormula

Figure 2-113 Options to specify the SmartFormula

In this dialog you can specify how the SmartFormula Manually dialog should open so that there is no need to change the basic settings every time (see section 2.4.11.4).
2.4.11.7.7 Updates

Figure 2-114 Options to specify updates

This dialog offers the possibility to be automatically informed when an update/upgrade of the software is available. If connected to the Internet the Compass 1.4 software checks for updates in configurable intervals: with every program start, daily, weekly, monthly, never. The displayed information will contain the respective contact address.

This feature opens a passive ftp connection to ftp.bdal.de, so a firewall (if present) needs to be configured accordingly. This is done by the installation for the firewall integrated into the Windows operating systems.

2.4.11.8 Colors

The Colors command is used to assign colors to particular screen elements in the Mass Spectrum window. Several screen elements are offered. New options to this flexAnalysis version are Background Peak Label and Annotation Label.
If peaks are recognized as background peaks *(Identify Backgrounds macro)* but have not yet been deleted from the peak list they will be shown colored with the color selected here. The annotations added via the new *Annotation* tool are also displayed in the color selected in this dialog.

**Figure 2-115  Colors dialog box**

### 2.4.11.9  Glycopeptides

For detailed information, please see the tutorial [Quickstart_Glycopeptides.pdf](#).

### 2.4.11.10  Send Spectra to ProteinScape

The *Send Spectra to ProteinScape* macro is used to send data to a ProteinScape server. Selecting this command opens the *Spectrum Browser* to select and load data.
2.4.12 Window Menu

![Window Menu](image)

Figure 2-116 Contents of the Window menu

Table 2-11 Features of the Window menu

<table>
<thead>
<tr>
<th>Feature button</th>
<th>Window menu commands</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Analysis List" /></td>
<td>Analysis List</td>
<td>ALT+1</td>
<td>Shows/Hides the Analysis List Window.</td>
</tr>
<tr>
<td><img src="image" alt="Mass Spectrum" /></td>
<td>Mass Spectrum</td>
<td>ALT+2</td>
<td>Shows/Hides the Mass Spectrum Window.</td>
</tr>
<tr>
<td><img src="image" alt="Mass List" /></td>
<td>Mass List</td>
<td>ALT+3</td>
<td>Shows/Hides the Mass List Window.</td>
</tr>
<tr>
<td><img src="image" alt="Sequence List" /></td>
<td>Sequence List</td>
<td>ALT+4</td>
<td>Shows/Hides the Sequence List Window.</td>
</tr>
<tr>
<td><img src="image" alt="SmartFormula List" /></td>
<td>SmartFormula List</td>
<td>ALT+5</td>
<td>Shows/Hides the SmartFormula List Window.</td>
</tr>
</tbody>
</table>

2.4.12.1 Analysis List

The Analysis List command, the corresponding icon of the toolbar, and the short cut (ALT+1) display or remove the analysis list from the GUI.

2.4.12.2 Mass Spectrum

The Mass Spectrum command, the corresponding icon of the toolbar, or the short cut (ALT+2) toggle the Mass Spectrum window and the Bruker symbol.
2.4.12.3 Mass List

The Mass List command, the corresponding icon of the toolbar , and the shortcut (ALT+3) display or hide the mass list from the GUI. When the Mass List window is shown, the tool button shown in front of this command is highlighted.

2.4.12.4 Sequence List

The Sequence List command, the corresponding icon of the toolbar , and the shortcut (ALT+4) fill this window with sequence tags, which can be created with the annotation feature (see section 2.4.6). If there is a gap in the sequence tag, a new entry with the next abbreviation of the currently chosen annotation will occur in this window. A sequence list can be saved together with a spectrum. After saving and closing a spectrum, the sequence list will be reloaded when the spectrum is reopened.

2.4.12.5 SmartFormula List

The SmartFormula List command, the corresponding icon of the toolbar , and the shortcut (ALT+5) display or hide the molecular formula list in the GUI. A SmartFormula list can be saved together with a spectrum. After saving and closing a spectrum, the SmartFormula list will be reloaded when the spectrum is reopened.

2.4.13 Compass Menu

![Compass Menu](image)

Figure 2-117 Content of the Compass menu
Table 2-12  Features of the Compass menu

<table>
<thead>
<tr>
<th>Compass menu commands</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License</td>
<td></td>
<td>Enter the License number here.</td>
</tr>
<tr>
<td>Operator</td>
<td></td>
<td>Changes the operator.</td>
</tr>
<tr>
<td>Lock all Applications</td>
<td>CTRL+ALT+K</td>
<td>Locks all programs in case the Compass Security Pack is installed.</td>
</tr>
<tr>
<td>Compass Desktop</td>
<td>F11</td>
<td>Opens the Compass Desktop.</td>
</tr>
<tr>
<td>FlexControl</td>
<td>CTRL+F11</td>
<td>Opens flexControl.</td>
</tr>
<tr>
<td>BioTools</td>
<td>ALT+ F12</td>
<td>Opens BioTools.</td>
</tr>
<tr>
<td>Audit Trail Viewer</td>
<td></td>
<td>Opens the Audit Trail Viewer in case the Compass Security Pack is installed.</td>
</tr>
</tbody>
</table>

2.4.13.1  License

The License command is used to open the Bruker Daltonics LicenseManager dialog box for viewing or adding/removing licenses for Bruker products. The LicenseManager looks the same in nearly all programs. It is not necessary to enter a license for a special Bruker program in the respective program; it can be entered via the LicenseManager of other Bruker programs.
2.4.13.2 Operator

The Operator command is used to log on as a new operator. The new operator name appears in the status bar at the bottom of the GUI. If the Bruker Daltonics UserManagement is installed, a password is requested.

If a user logs on with the Operator command the user automatically changes for all other Bruker programs that are currently open and running with UserManagement. If flexControl is running, it asks the user for a new acquisition method.

2.4.13.3 Lock All Applications

The Lock All Applications command and the shortcut (CTRL+ALT+K) lock all Bruker applications that are currently open and opens the Unlock dialog. The duration depends on the lock-time defined in UserManagement.

If one program is locked (manually or via timeout), all programs that run with the UserManagement are locked, since they all use the same UserManagement server. In this case it is necessary to unlock only one program. A locked program can only be unlocked by the user who locked it or the UserManagement administrator.

Note The Lock All Applications command is only available if Bruker Daltonics UserManagement is installed.
2.4.13.4 Compass Desktop

The Compass Desktop command opens the so called Bruker Compass. This GUI offers access to installed Bruker programs under Acquisition, Processing, and Data Interpretation, and their user manuals.

![Compass Desktop GUI](image)

Figure 2-119 Compass Desktop GUI

2.4.13.5 flexControl

The flexControl command is used to open flexControl or bring it to front if it is already open. Data transfer cannot be performed using this or any other command.

2.4.13.6 BioTools

The BioTools command is used to open BioTools or bring it to front if it is already open. Data transfer — for example, sending a spectrum to BioTools — cannot be performed using this command. To send spectra to BioTools use the BioTools command in the Tools menu (see section 2.4.11.1).
2.4.13.7  Audit Trail Viewer

The **Audit Trail Viewer** command opens the **Bruker Daltonics AuditTrailViewer** dialog. This command is only available if the Bruker UserManagement is installed.

![Audit Trail Viewer](image)

**Figure 2-120  Audit Trail Viewer**

2.4.14  Help Menu

![Help Menu](image)

**Figure 2-121  Contents of the Help menu**
Table 2-13  Features of the Help menu

<table>
<thead>
<tr>
<th>Feature button</th>
<th>Help menu commands</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Help Topics</td>
<td>F1</td>
<td>Opens the help file.</td>
</tr>
<tr>
<td></td>
<td>About Bruker Daltonics flexAnalysis</td>
<td></td>
<td>Opens the About Window</td>
</tr>
</tbody>
</table>

2.4.14.1  Help Topics

The **Help Topics** command, the corresponding icon of the toolbar, and the shortcut (F1) open the flexAnalysis online-help to get information about specific topics.

2.4.14.2  About Bruker Daltonics flexAnalysis

This command opens the **About** dialog (see Figure 2-122) that displays the version number of your flexAnalysis version with the copyright notice, the user-specific license information, and contact information of Bruker Daltonik GmbH.

![About dialog](image)

*Figure 2-122  About dialog*
2.5 Window Areas

2.5.1 Analysis List Window

The Analysis List window (or tree view) is used to display one or more selected analyses and their related spectra. Analyses can be arranged by dragging & dropping.

The tree view (see Figure 2-123) of flexAnalysis 3.4 offers several improvements over previous versions.

![Analysis List Window](image)

Figure 2-123 flexAnalysis tree view

Each icon reflects the color of the respective spectrum. When a spectrum is expanded, four sections are shown, allowing fast access to the spectrum parameters, the method, and the new calibration information window (see Figure 2-16).

2.5.2 Mass Spectrum Window

The Mass Spectrum window (or display) is used to display a spectrum or spectra of one or more analyses selected in the Analysis List window.

When a spectrum is displayed and the mouse pointer is within the window boundaries, two interactive mouse pointer modes are available.

**Edit** mode (see section 2.4.3.2) → mouse pointer + CTRL

**Zoom** mode (see section 2.4.9.7) → mouse pointer + SHIFT

Switch between modes by pressing either CTRL or SHIFT (the mouse pointer must be in the Mass Spectrum window).
2.5.3 Mass List Window

The Mass List window (or peak list) displays masses and peak parameters of a selected spectrum in the Mass Spectrum window or the Analysis List window. Only one mass list is displayed at a time. This list layout can be customized (see section 2.4.7.5.4).

2.5.4 Sequence List Window

The Sequence List window displays the annotations (mass differences) and sequences of a spectrum selected in the Analysis List window.

2.5.5 SmartFormula List Window

The Molecular Formula Result List window displays the SmartFormula results from a spectrum selected in the Analysis List window.

2.6 flexAnalysis Window Shortcut Menus

Right-clicking in a flexAnalysis window opens a menu with shortcuts to menu commands. For more information on the individual commands, see the description in the respective menu section.

2.6.1 Analysis List Window (Tree View) Shortcut Menu

Clicking within the body of the Analysis List window opens a shortcut menu containing commands for handling data and changing the appearance of the window (see Figure 2-124).
2.6.2 **Mass Spectrum Window (Display View) Shortcut Menu**

Clicking within the body of the Mass Spectrum window opens a shortcut menu containing commands for manipulating spectra (see Figure 2-125).
Clicking next to the x- or y-axis opens a shortcut menu for altering the axis scales and labeling (see Figure 2-126).

**Figure 2-125  Display view shortcut menu options**

**Figure 2-126  Spectrum axis shortcut menu**
Hide Y-axis

Show/Hide the intensity (y) axis.

Axis Font

Opens a dialog, where you can change font, font style and size of the x-/ y-axis and the spectra labeling.

2.6.3 Mass List (Peak List) View Shortcut Menu

Clicking on an entry in an existing mass list within the Mass List window opens a shortcut menu containing commands for handling mass control lists (see Figure 2-127).

![Mass List window shortcut menu options](image)

**Figure 2-127** Mass List window shortcut menu options

For information on the Add to MS/MS command, see section 2.4.3.5.

Clicking within the Mass List window beneath an existing mass list opens an alternative shortcut menu (see Figure 2-128).
Figure 2-128  Alternative Mass List window shortcut menu options

A third shortcut menu is opened by clicking within the empty Mass List window (see Figure 2-129).

Figure 2-129  Empty Mass List window shortcut menu options

Show/Show always

Depending on the chosen peak picking algorithm to label the peak of interest different things can be visualized with the **Show/Show always** function. If **SNAP** is used, the isotopic distribution of the fitted peak is shown as an area. With **Centroid** or **Sum** a Gauss curve of the molecular weight is shown as area. With the **Show** function only one peak of interest is shown. If you activate the **Show always** function, you can choose different peaks in the mass list window and each time the corresponding area is shown.
Note: The calculated SNAP areas can only be shown as long as the spectrum is not closed. If the spectrum has been closed and reopened only a line is shown, which shows the isotopic distribution of the fitted peak. If you want to visualize the area again, the peak list has to be recalculated, this means you have to select the Mass List > Find or Mass List > Edit command again.

2.7 Pointers and Interactive Modes

Different mouse pointers are available in flexAnalysis, each has a specific function that facilitates using the software.

Data Pointer

The data pointer moves with the arrow pointer of the mouse within the Mass Spectrum window. In the case of two or more spectra the data pointer resides on the last generated spectrum. The m/z value and the related intensity of the current position of the data pointer are displayed at the right edge of the status bar.

Pointers for Direct Manipulation

Horizontal Window Border: 

These pointers are used to change the height of windows and are displayed when the mouse pointer is positioned on the upper or lower border.

Vertical Window Border: 

These pointers are used to change the width of windows and are displayed when the mouse pointer is positioned on the left or right border.

Horizontal Scaling:

This pointer appears below the x-axis of the Mass Spectrum window and is used to shift the spectrum and the scale horizontally.

Vertical Scaling:

This pointer appears beside the y-axis of the Mass Spectrum window and is used to shift the spectrum and the scale vertically.
Column Width: ➪

This pointer is used to change the width of columns, such as those in the Mass List window, and is displayed when the mouse pointer is positioned on the left or right border of a column header.

Pick:

This pointer is used to directly select a mass spectrum in the Mass Spectrum window. It is displayed when the mouse pointer is positioned within 3 pixels of a data point of an unselected mass spectrum.

Interaction Mode Mouse Pointers

Zoom In: ➢

This pointer is used to zoom the display range of a data window. It is displayed when the Zoom In mode is active and when the mouse pointer is positioned on a data window's display.

Access: Mouse pointer + SHIFT \(\rightarrow\) Zoom mode (see section 2.4.9.6).

Edit Mass List Pointers

These pointers are used to add a peak or to delete a peak from the Mass List in a spectrum displayed in the Mass Spectrum window. They are displayed in addition to the Data pointer, when the Edit Mass List mode is active and the mouse pointer is positioned on the selected spectrum.

The pointer that is displayed at any given time depends on the actual position of the Data pointer.

The Delete pointer \(\times\) appears when the Data pointer is positioned on a data point that belongs to a mass peak already present in the spectrum's mass list.

The Add pointer \(\uparrow\downarrow\) appears when the Data pointer is positioned on a data point whose mass peak is not yet present in the Mass List window.

Access: Mouse pointer + CTRL \(\rightarrow\) Edit mode (see section 2.4.3.2).
The Internal Calibration pointer: ![Internal Calibration Pointer](image) is used for internal calibration of analysis mass spectra. It is used to manually select a peak from a mass spectrum displayed in the Mass Spectrum window and to assign it to a selected reference mass. It is displayed in addition to the Data pointer when the **Internal** command from the **Tools** menu is active and the mouse pointer is positioned on the selected mass spectrum.

### 2.8 flex Data Converter

The **flex Data Converter** is an utility for converting data sets between the traditional XMass data format and the new Container data format (see section 2.4.1.2). The converter creates a copy of the data set; the original data set is not modified.

The **flex Data Converter** is launched from the **Start** menu under **Programs > Bruker Daltonics > Utilities > flex Data Converter**.

The **flex Data Converter** runs as a wizard with the following steps:

1. **Welcome** page (see Figure 2-130).
2. **Select Spectra** page (see Figure 2-131). Click **Browse** to open the **Spectrum Browser** dialog and select the desired spectra.
3. **Select Destination** page (see Figure 2-132). Choose the destination directory here.
4. **Select Format** page (see Figure 2-133). Specify the requested output format: XMass or Container.
5. **Conversion Options** page (see Figure 2-134). By default, the data converter tries to retain the current processing state of the spectra. The options here can be used to undo certain processing steps.
6. **Summary** page (see Figure 2-135). This page lists the selected options. Clicking **Start** starts the conversion.
7. **Convert Spectra** page (see Figure 2-136). This page displays the progress of the conversion.
8. **Conversion Summary** page (see Figure 2-137). Shown after conversion completion, when the converted data set is ready for use.
Welcome to the Flex Data Converter Wizard

This wizard helps you to convert maldi data from one format to another.

Figure 2-130  flex Data Converter wizard Welcome page
Figure 2-131  flex Data Converter wizard Select Spectra page
Figure 2-132  flex Data Converter wizard Select Destination page
**Figure 2-133**  flex Data Converter wizard Select File Format page
**Figure 2-134**  flex Data Converter wizard Set Conversion Options page
Figure 2-135  flex Data Converter wizard Summary page
Figure 2-136   flex Data Converter wizard Convert Spectra page
Figure 2-137 flex Data Converter wizard Conversion Summary page
Appendix A — Calibration

A.1 Calibration Procedures

The following paragraphs summarize the three different recalibration procedures.

A.1.1 Performing an Internal Calibration Using the Statistical Peptide Calibration Feature

1. Select exactly one spectrum in the Analysis List window.
   Make sure that this spectrum is displayed in the Mass List window.

2. Open the Internal Mass Spectrum Calibration dialog and select Statistical peptide (if not already selected).

3. Read the Golden Rules for Statistical Calibrations (see section 2.4.5.1.1).

4. Click Calibrate.

5. If the new calibration is satisfactory, click OK.

A.1.2 Performing an Internal Calibration Using the Automatic Assignment Feature

1. Select exactly one spectrum in the Analysis List window.
   Make sure that this spectrum is displayed in the Mass List window.

2. Open the Internal Mass Spectrum Calibration dialog, select Interactive and choose a calibration list containing the masses the calibrants in the spectrum.

3. Click on a row in the calibration list that contains a calibrant present in the spectrum.
   The row is marked with a red arrow indicating that the calibrant is in use, but not assigned. If the zoom range setting is correct, the calibrant peak will be displayed in the Mass Spectrum window.

4. Select the calibrant peak in the Mass Spectrum window by clicking to the left of the peak.
If the assignment was successful the **Current mass** entry and the **Error** entry are filled with the calculated values and the row is marked with a green arrow. The calibration constants displayed in the dialog \((c_0 - c_2)\) are also updated.

Any improvement in the calibration due to the new calculation can be evaluated by checking the standard deviation values before and after calibration. The calibration constants can be checked by clicking **Properties**.

5. Repeat steps 3 and 4 until all entries in the reference mass list or all the calibrant peaks in the spectrum have been assigned.

To remove a calibration assignment from the table, click the corresponding mass. Note that the button **Clear** removes all the previously matched masses!

### A.2 High-Precision Polynomial Calibration (HPC)

#### A.2.1 What is HPC?

HPC is a fine correction of the calibration in the mass range between 700 and 4000 Da available on ultraflex mass spectrometers.

The use of any kind of pulsed ion extraction in time of flight mass spectrometry distorts the linear relationship between \(m/z\) and the square of the ion flight time. By empirically fitting the residual deviation (few ppm) from the ideal quadratic calibration by a high order polynomial (HPC) one can significantly increase mass accuracy, esp. for masses below 1 kDa. For details please refer to Gobom J. et al., Anal. Chem. 2002, 74, 3915-3923.

#### A.2.2 Using HPC

Ultraflex instruments (production 4/03 or later) are equipped with a dedicated HPC flexControl acquisition method called **Proteomics_HPC.par**. This method preset at the factory contains all relevant HPC parameters and must not be changed. If you change any of the instrument voltages or the deflection pulser settings the HPC method becomes invalid!

Use **Proteomics_HPC.par** for all standard proteomics applications and the HPC correction is automatically performed in flexControl3.x and flexAnalysis3.x without any user interaction for all spectra acquired with this method. Use the common calibration and mass list generation procedures for those spectra.
**Note**  HPC only eliminates the deviations from the quadratic calibration function, and does not replace a good quadratic calibration.

### A.2.1 Checking HPC Performance

HPC performance can be checked by acquiring mass spectra of samples with about 10 known peaks in the mass range 750 Da - 3500 Da using the HPC method `Proteomics_HPC.par`. The most relevant HPC correction takes place below 1 kDa, and it is therefore essential that the sample contains calibrants between 750 Da and 1000 Da. We recommend using the Bruker PeptideCalibration standard supplemented with Bradykinin (fragment 1-7, 757 Da) to cover the low mass range.

After mass spectra acquisition, perform internal quadratic calibrations with flexAnalysis using the known 10 peaks as calibrants. If HPC is switched on (select check box in flexAnalysis) typical mean mass errors of about 3–5 ppm are achieved. If the HPC check box is cleared, results are significantly worse (about 10 ppm).

### A.3 Table of Valences

Valences used for calculation of ring and double bonds, electron configuration and nitrogen rule in the **Tools > Generate Formula** command are given below.

<table>
<thead>
<tr>
<th>Atom</th>
<th>Valence</th>
<th>Atom</th>
<th>Valence</th>
<th>Atom</th>
<th>Valence</th>
<th>Atom</th>
<th>Valence</th>
</tr>
</thead>
<tbody>
<tr>
<td>H</td>
<td>1</td>
<td>Ni</td>
<td>2</td>
<td>La</td>
<td>3</td>
<td>Rn</td>
<td>0</td>
</tr>
<tr>
<td>D</td>
<td>1</td>
<td>Cu</td>
<td>1</td>
<td>Ce</td>
<td>4</td>
<td>Fr</td>
<td>1</td>
</tr>
<tr>
<td>T</td>
<td>1</td>
<td>Zn</td>
<td>2</td>
<td>Pr</td>
<td>3</td>
<td>Ra</td>
<td>2</td>
</tr>
<tr>
<td>He</td>
<td>0</td>
<td>Ga</td>
<td>3</td>
<td>Nd</td>
<td>3</td>
<td>Ac</td>
<td>3</td>
</tr>
<tr>
<td>Li</td>
<td>1</td>
<td>Ge</td>
<td>4</td>
<td>Pm</td>
<td>3</td>
<td>Th</td>
<td>4</td>
</tr>
<tr>
<td>Be</td>
<td>2</td>
<td>As</td>
<td>3</td>
<td>Sm</td>
<td>2</td>
<td>Pa</td>
<td>4</td>
</tr>
<tr>
<td>B</td>
<td>3</td>
<td>Se</td>
<td>2</td>
<td>Eu</td>
<td>2</td>
<td>U</td>
<td>3</td>
</tr>
<tr>
<td>C</td>
<td>4</td>
<td>Br</td>
<td>1</td>
<td>Gd</td>
<td>3</td>
<td>Np</td>
<td>3</td>
</tr>
<tr>
<td>N</td>
<td>3</td>
<td>Kr</td>
<td>0</td>
<td>Tb</td>
<td>3</td>
<td>Pu</td>
<td>3</td>
</tr>
<tr>
<td>O</td>
<td>2</td>
<td>Rb</td>
<td>1</td>
<td>Dy</td>
<td>3</td>
<td>Am</td>
<td>3</td>
</tr>
<tr>
<td>Atom</td>
<td>Valence</td>
<td>Atom</td>
<td>Valence</td>
<td>Atom</td>
<td>Valence</td>
<td>Atom</td>
<td>Valence</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
<td>------</td>
<td>---------</td>
<td>------</td>
<td>---------</td>
<td>------</td>
<td>---------</td>
</tr>
<tr>
<td>F</td>
<td>1</td>
<td>Sr</td>
<td>2</td>
<td>Ho</td>
<td>3</td>
<td>Cm</td>
<td>3</td>
</tr>
<tr>
<td>Ne</td>
<td>0</td>
<td>Y</td>
<td>3</td>
<td>Er</td>
<td>3</td>
<td>Bk</td>
<td>3</td>
</tr>
<tr>
<td>Na</td>
<td>1</td>
<td>Zr</td>
<td>4</td>
<td>Tm</td>
<td>3</td>
<td>Cf</td>
<td>3</td>
</tr>
<tr>
<td>Mg</td>
<td>2</td>
<td>Nb</td>
<td>5</td>
<td>Yb</td>
<td>2</td>
<td>Es</td>
<td>3</td>
</tr>
<tr>
<td>Al</td>
<td>3</td>
<td>Mo</td>
<td>6</td>
<td>Lu</td>
<td>3</td>
<td>Fm</td>
<td>3</td>
</tr>
<tr>
<td>Si</td>
<td>4</td>
<td>Tc</td>
<td>4</td>
<td>Hf</td>
<td>4</td>
<td>Md</td>
<td>3</td>
</tr>
<tr>
<td>P</td>
<td>3</td>
<td>Ru</td>
<td>3</td>
<td>Ta</td>
<td>5</td>
<td>No</td>
<td>2</td>
</tr>
<tr>
<td>S</td>
<td>2</td>
<td>Rh</td>
<td>3</td>
<td>W</td>
<td>6</td>
<td>Lr</td>
<td>3</td>
</tr>
<tr>
<td>Cl</td>
<td>1</td>
<td>Pd</td>
<td>2</td>
<td>Re</td>
<td>4</td>
<td>Rf</td>
<td>0</td>
</tr>
<tr>
<td>Ar</td>
<td>0</td>
<td>Ag</td>
<td>1</td>
<td>Os</td>
<td>3</td>
<td>Db</td>
<td>0</td>
</tr>
<tr>
<td>K</td>
<td>1</td>
<td>Cd</td>
<td>2</td>
<td>Ir</td>
<td>3</td>
<td>Sg</td>
<td>0</td>
</tr>
<tr>
<td>Ca</td>
<td>2</td>
<td>In</td>
<td>3</td>
<td>Pt</td>
<td>2</td>
<td>Bh</td>
<td>0</td>
</tr>
<tr>
<td>Sc</td>
<td>3</td>
<td>Sn</td>
<td>4</td>
<td>Au</td>
<td>1</td>
<td>Hs</td>
<td>0</td>
</tr>
<tr>
<td>Ti</td>
<td>4</td>
<td>Sb</td>
<td>5</td>
<td>Hg</td>
<td>2</td>
<td>Mt</td>
<td>0</td>
</tr>
<tr>
<td>V</td>
<td>5</td>
<td>Te</td>
<td>2</td>
<td>Tl</td>
<td>3</td>
<td>Ds</td>
<td>0</td>
</tr>
<tr>
<td>Cr</td>
<td>3</td>
<td>I</td>
<td>1</td>
<td>Pb</td>
<td>4</td>
<td>Uuu</td>
<td>0</td>
</tr>
<tr>
<td>Mn</td>
<td>2</td>
<td>Xe</td>
<td>0</td>
<td>Bi</td>
<td>5</td>
<td>Uub</td>
<td>0</td>
</tr>
<tr>
<td>Fe</td>
<td>2</td>
<td>Cs</td>
<td>1</td>
<td>Po</td>
<td>2</td>
<td>Uuq</td>
<td>0</td>
</tr>
<tr>
<td>Co</td>
<td>2</td>
<td>Ba</td>
<td>2</td>
<td>At</td>
<td>1</td>
<td>Uuh</td>
<td>0</td>
</tr>
</tbody>
</table>
# Index

## A
- About command 151
- Analysis List command 145
- Analysis Window 152
- Auto-Scaling command 109

## B
- Batch Process command 52
- BioTools command 120
- Box Selection command 40

## C
- Change Parameters command 106
- Clear command 44
- Clear Range Selection command 40
- Close command 27
- Color command 39
- Colors command 143
- Compass Security Pack 13
- Copy Calibration command 71
- Copy command 37
- Customize command 134

## D
- Default Color command 40
- Delete command 38
- Delete Segment Spectra command 107
- Distance in Masses command 49

## E
- Edit Building Blocks command (Annotation menu) 77
- Edit command 43
- Edit Parameters command 83
- Edit Script command 102
- Exit command 34
- Export command 31

## F
- Files for recalibration 26
- Filter Background Peaks command 49
- Find command 42

## H
- Help Topics command 151
- High Precision Calibration 140, 170-171
- Horizontal Auto-Scaling command 110

## I
- Installation 15
- Interactive modes 152
- Internal Calibrate command 60
- Internal calibration procedure 169

## L
- License command 148-149
- Lock all Applications command 148
### M
- **Macro Editor command** 133
- **Mass List command** 146
- **Mass List Window** 153
- **Mass Spectrum Command** 145
- **Mass Spectrum Window** 152
- **Menu Bar** 21
- **Microsoft .NET Framework** 13

### S
- **Save All command** 29
- **Save As command** 29, 82
- **Save As HTML command** 117
- **Save As PDF command** 116
- **Save command** 82
- **Scale to Entire Spectrum command** 110
- **Select All command** 38
- **Select Default command** 103
- **Select None command** 38
- **Sequence List command** 146
- **Set Display Range command** 110
- **SmartFormula List command** 146
- **SmartFormula Manually command** 124
- **Smooth Mass spectrum command** 52
- **Statistical peptide calibration procedure** 169
- **Status Bar command** 113
- **Statusbar** 20
- **Subtract Mass Spectrum Baseline command** 52

### R
- **Range Selection command** 40
- **Redo Zooming command** 111
- **Replace Calibration command** 71
- **Report Designer command** 117
- **Rules for statistical calibration** 69
- **Run Script command** 83
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>U</strong></td>
</tr>
<tr>
<td>Undo All Processing command</td>
</tr>
<tr>
<td>Undo Zooming command</td>
</tr>
<tr>
<td>User management</td>
</tr>
<tr>
<td><strong>V</strong></td>
</tr>
<tr>
<td>View Analysis command</td>
</tr>
<tr>
<td>View Spectrum command</td>
</tr>
<tr>
<td><strong>W</strong></td>
</tr>
<tr>
<td>Window menu</td>
</tr>
<tr>
<td><strong>Z</strong></td>
</tr>
<tr>
<td>Zoom command</td>
</tr>
<tr>
<td>Zoom X command</td>
</tr>
</tbody>
</table>